## Document Change Record

This page records changes to this document. The document was originally released as Revision 001.

<table>
<thead>
<tr>
<th>Version Number</th>
<th>Date</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>005</td>
<td>2/2011</td>
<td>Revised manual to correct the following sections:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Connecting to a Bluetooth Scanner” on page 35.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “EA20X Extended Range Area Imager Minimum Reading Distances” on page 86.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Single Dock (AD20)” on page 94.</td>
</tr>
<tr>
<td>004</td>
<td>6/2010</td>
<td>Revised manual to add the EX25C imager and update supported bar code symbologies.</td>
</tr>
<tr>
<td>003</td>
<td>10/2009</td>
<td>Revised manual to add the large 28-key numeric keypad and the CK3NI model.</td>
</tr>
<tr>
<td>002</td>
<td>3/2009</td>
<td>Revised manual to support the new CK3a1 and CK3n1 models, and the DDIB 802.11 a/b/g radio module.</td>
</tr>
</tbody>
</table>
## Contents

Before You Begin ................................................................. ix  
Safety Information ............................................................. ix  
Global Services and Support .............................................. ix  
  Warranty Information ....................................................... ix  
  Web Support ................................................................. x  
  Telephone Support ......................................................... x  
  Service Location Support ............................................... x  
Who Should Read This Manual ........................................... xi  
Related Documents .......................................................... xi  
Patent Information ........................................................... xii

### 1 Using the Computer ...................................................... 1

Introducing the CK3 Mobile Computer .................................. 2  
What's New? ................................................................. 4  
Using the Battery ............................................................ 4  
  Charging the Battery ..................................................... 5  
  Removing and Installing the Battery ................................ 5  
  Maximizing Battery Life ................................................ 6  
  Checking the Battery Status ........................................... 7  
Using the Keypad ............................................................ 8  
  Using the Color-Coded Keys .......................................... 9  
  Capitalizing Characters ............................................... 10  
  Using the Power Button ............................................... 11  
  Configuring the Backlight Settings ................................ 11  
Understanding the Audio Features ..................................... 12  
  Adjusting the Volume of the Speaker ............................... 12  
  Using the Push To Talk (PTT) Feature ............................... 12  
    Recording Audio on Your CK3 ..................................... 12  
    Using Your CK3 as a Two-Way Radio ............................ 13  
Using the Touch Screen .................................................. 13  
  Using the Stylus .......................................................... 14  
  Understanding the Screen Icons ................................... 14  
  Aligning the Touch Screen ......................................... 15  
Understanding the Status LEDs ....................................... 16
Contents

1 Scanning Bar Codes .......................................................... 17
   Scanning With the Linear Imager ....................................... 18
   Scanning With an Area Imager ......................................... 19
   Scanning With the Extended Range Area Imager .................... 19
   Scanning With the Near-Far Range Area Imager ..................... 20
   Improving the Performance of the Area Imager ...................... 21

Using a microSD Card .......................................................... 23

2 Connecting and Configuring the CK3 ................................. 27
   Managing the CK3 Using SmartSystems Foundation ................. 28
   Connecting to a PC ...................................................... 28
   Configuring the CK3 Parameters ...................................... 30
      Using Intermec Settings Remotely With SmartSystems Foundation . 30
      Using Intermec Settings Directly on the CK3 ...................... 31
      Hiding Menu Items in Intermec Settings ......................... 32
      Configuring the CK3 Remotely With SmartSystems Foundation .... 33
   Configuring the CK3 for Your Network ............................... 33
      Configuring 802.11 Radio Communications ....................... 33
      Configuring Bluetooth Communications ......................... 34
         Connecting to a Bluetooth Scanner ............................ 35
         Configuring Bluetooth Communications for Wireless Printing ... 37
         Connecting to a Bluetooth Audio Device ...................... 38
      Configuring Ethernet Communications .......................... 39
      Using Serial and USB Communications ........................... 40
      Checking the Status of Your Wireless Connection ............... 40
   Configuring Wireless Security ......................................... 41
      Choosing Between Funk and Microsoft Security .................. 42
         Selecting a Funk Security Profile ............................. 42
         Selecting Microsoft as Your Security Choice ................. 47
      Loading a Certificate .............................................. 50
      Disabling Security .................................................. 52

3 Developing and Installing Applications .............................. 53
   Developing Applications for the CK3 ................................. 54
   Packaging Your Application .......................................... 54
Contents

Installing Applications on the CK3 ............................................. 55
  Installing Applications Using SmartSystems Foundation ............ 55
  Installing Applications Using Microsoft ActiveSync ................. 55
  Installing Applications Using a Storage Card ......................... 56
  Installing Applications Using the FTP Server .......................... 56

Freeing Up Virtual Memory for Applications .............................. 57

Launching an Application Automatically ..................................... 59

Upgrading the System Software ............................................... 60
  Upgrading the CK3 Using a microSD Card ......................... 61
  Upgrading the CK3 Using SmartSystems Foundation ........... 62

4 Troubleshooting and Maintaining the CK3 .............................. 65

Calling Product Support ....................................................... 66

Troubleshooting Your CK3 ..................................................... 67
  Checking 802.11 Network Status ........................................ 73

Resetting the CK3 .............................................................. 77
  Warm Booting the CK3 .................................................... 77
  Cold Booting the CK3 .................................................... 77
  Clean Booting the CK3 ................................................... 78

Cleaning the Scanner Window and Screen ................................. 80

A Specifications ................................................................. 81

Physical and Environmental Specifications ............................... 82

Accessories ................................................................. 94

B Default Settings .............................................................. 97

Default Configuration ..................................................... 98

C Keypads and Keystrokes .................................................... 107

Standard Characters ......................................................... 108

CK3 Mobile Computer User’s Manual
Before You Begin

This section provides you with safety information, technical support information, and sources for additional product information.

Safety Information

Your safety is extremely important. Read and follow all warnings and cautions in this document before handling and operating Intermec equipment. You can be seriously injured, and equipment and data can be damaged if you do not follow the safety warnings and cautions.

This section explains how to identify and understand warnings, cautions, and notes that are in this document.

A warning alerts you of an operating procedure, practice, condition, or statement that must be strictly observed to avoid death or serious injury to the persons working on the equipment.

A caution alerts you to an operating procedure, practice, condition, or statement that must be strictly observed to prevent equipment damage or destruction, or corruption or loss of data.

Note: Notes either provide extra information about a topic or contain special instructions for handling a particular condition or set of circumstances.

Global Services and Support

Warranty Information

To understand the warranty for your Intermec product, visit the Intermec web site at www.intermec.com and click Support > Returns and Repairs > Warranty.
Before You Begin

Disclaimer of warranties: The sample code included in this document is presented for reference only. The code does not necessarily represent complete, tested programs. The code is provided “as is with all faults.” All warranties are expressly disclaimed, including the implied warranties of merchantability and fitness for a particular purpose.

Web Support
Visit the Intermec web site at www.intermec.com to download our current manuals (in PDF).

Visit the Intermec technical knowledge base (Knowledge Central) at www.intermec.com and click Support > Knowledge Central to review technical information or to request technical support for your Intermec product.

Telephone Support
In the U.S.A. and Canada, call 1-800-755-5505.

Outside the U.S.A. and Canada, contact your local Intermec representative. To search for your local representative, from the Intermec web site, click About Us > Contact Us.

Service Location Support
For the most current listing of service locations, click Support > Returns and Repairs > Repair Locations.

For technical support in South Korea, use the after service locations listed below:

AWOO Systems
102-1304 SK Ventium
522 Dangjung-dong
Gunpo-si, Gyeonggi-do Korea, South 435-776
Contact: Mr. Sinbum Kang
Telephone: +82-31-436-1191
E-mail: mjyun@awoo.co.kr
Before You Begin

IN Information System PTD LTD
6th Floor
Daegu Venture Center Bldg 95
Shinchun 3 Dong
Donggu, Daegu City, Korea
E-mail: jmyou@idif.co.kr or korlim@gw.idif.co.kr

Who Should Read This Manual

This manual is for the person who is responsible for installing, configuring, and maintaining the CK3 Mobile Computer. In this manual, CK3 refers to models CK3a, CK3a1, CK3n, CK3n1, and CK3NI, unless specifically stated otherwise.

This manual provides you with information about the features of the CK3, including how to install, configure, operate, maintain, and troubleshoot it.

Before you work with the CK3, you should be familiar with your network and general networking terms, such as IP address.

Related Documents

The Intermec web site at www.intermec.com contains our documents (as PDF files) that you can download for free.

To download documents

1 Visit the Intermec web site at www.intermec.com.
2 Click the Products tab.
3 Using the Products menu, navigate to your product page. For example, to find the CK3 computer product page, click Computers > Handheld Computers > CK3.
4 Click the Manuals tab.

If your product does not have its own product page, click Support > Manuals. Use the Product Category field, the Product Family field, and the Product field to help you locate the documentation for your product.
Before You Begin

Patent Information

Product is covered by one or more of the following patents:

4953113; 4961043; 4970379; 4988852; 5019699; 5021642; 5038024;
5081343; 5095197; 5144119; 5144121; 5182441; 5187355; 5187356;
5195183; 5216233; 5216550; 5218191; 5227614; 5233172; 5241488;
5243602; 5258606; 5278487; 5288985; 5308966; 5322991; 5331136;
5331580; 5342210; 5349678; 5359185; 5371858; 5373458; 5389770;
5397885; 5410141; 5414251; 5416463; 5442167; 5464972; 5468947;
5468950; 5477044; 548689; 5488575; 5500516; 5502297; 5504367;
5508599; 5514858; 5530619; 5534684; 5536924; 5539191; 5541419;
5548108; 5550362; 5550364; 5565669; 5567925; 5568645; 5572007;
5576529; 5592512; 5594230; 5598007; 5608578; 5616909; 5619027;
5627360; 5640001; 5657317; 5659431; 5671436; 5672860; 5684290;
5719678; 5729003; 5742041; 5761219; 5764798; 5777308; 5777309;
5777310; 5786583; 5793604; 5798509; 5798513; 5804805; 5805807;
5811776; 5811777; 5818027; 5821523; 5828052; 5831819; 5834749;
5834753; 5837987; 5841121; 5842070; 5844222; 5854478; 5862267;
5869840; 5873070; 5877486; 5878395; 5883492; 5883493; 5886338;
5889386; 5892971; 5895906; 5898162; 5902987; 5902988; 5912452;
5923022; 5936224; 5949056; 5969321; 5969326; 5969328; 5979768;
5986435; 5987192; 5987499; 5992750; 6003775; 6012640; 6016960;
6018597; 6024289; 6034379; 6036093; 6039252; 6064763; 6075340;
6095422; 6097839; 6102289; 6102295; 6109528; 6119941; 6128414;
6138915; 6149061; 6149063; 6152370; 6155490; 6158661; 6164542;
6164545; 6173893; 6195053; 6234393; 6234395; 6244512; 6249008;
6328214; 6330975; 6345765; 6356949; 6367699; 6375075; 6375076;
6375344; 6431451; 6435411; 6484944; 6488209; 6497368; 6532152;
6538413; 6539422; 6621942; 6641046; 6681994; 6687403; 6688523;
6732930; 6859190; 6889903; 6967280; 7027037; 7035466; 7090137;
7121467.

Docking station or device: 5052943; 5195183; 5317691; 5331580;
554010; 5644471.

There may be other U.S. and foreign patents pending.
Using the Computer

This chapter introduces the CK3 Mobile Computer with Windows® Mobile® 6.1 and contains these topics:

- Introducing the CK3 Mobile Computer
- What’s New?
- Using the Battery
- Using the Keypad
- Understanding the Audio Features
- Using the Touch Screen
- Understanding the Status LEDs
- Scanning Bar Codes
- Using a microSD Card
Chapter 1 — Using the Computer

Introducing the CK3 Mobile Computer

The Intermec CK3 Mobile Computer is an ergonomically designed mobile computer built on the Microsoft® Windows® Mobile 6.1 operating system. The CK3 is lightweight, easy-to-use, and runs most software developed for the Windows Mobile platform, including standalone, client-server, and browser-based applications. In this manual, CK3 refers to models CK3a, CK3a1, CK3n, CK3n1, and CK3NI, unless specifically stated otherwise.

CK3 Mobile Computer

The CK3a and CK3n Mobile Computer with a DHIB 802.11b/g radio installed is Wi-Fi® certified for interoperability with other 802.11b/g wireless LAN devices.

The CK3a1 and CK3n1 Mobile Computer with a DDIB 802.11a/b/g radio installed is Wi-Fi® certified for interoperability with other 802.11a/b/g wireless LAN devices.
The CK3 is available with the following features:

- 802.11b/g or 802.11a/b/g and Bluetooth® radio, standard
  
  **Note:** The radio also supports the 802.11d standard. The 802.11d standard adds the requirements and definitions for 802.11 WLAN equipment to operate in markets not served by the current standard. For 802.11d support, you need to order the 802.11d version of the CK3. For help, contact your local Intermec representative.

- 128 MB DRAM, 64 MB Flash
- 512 MB embedded SD Mass Storage Card
- Alphanumeric or numeric keypad
- Imaging options:
  - EV12 linear imager
  - EA20X extended range area imager
  - EX25B or EX25C near-far range area imager
- Intermec Client Pack (Optional):
  - Intermec Terminal Emulator, including 3270, 5250, and VT/ANSI, and support for third-party TE applications
  - Intermec Browser
  
  **Note:** The Intermec Client Pack is not compatible with the new large 28-key numeric keypad option.

Use this manual to understand how to use the features and options available on the CK3. For information about Windows Mobile 6.1 applications installed on the CK3, refer to the online help.
Chapter 1 — Using the Computer

What’s New?

This version of the CK3 Mobile Computer User’s Manual contains these enhancements:

- Corrected the connecting to a Bluetooth scanner section.
- Correct the follow appendix sections:
  - EA20X Extended Range Area Imager Minimum Reading Distances
  - Single Dock (AD20)

Using the Battery

The CK3 uses an AB17 standard or AB18 extended battery as its main power source. The standard battery has a 7.4 Watt hour capacity, and the extended battery has a 18.8 Watt hour capacity. Several factors determine the life of your battery, such as extreme temperatures, input devices, and your usage.

You must fully charge the battery before you can use the CK3. When you change the battery, an internal super capacitor maintains your status, memory, and real-time clock for approximately 10 minutes.

The battery used in this device may present a fire or chemical burn hazard if it is mistreated. Do not disassemble it, heat it above 100°C (212°F) or incinerate it. Dispose of used batteries promptly. Keep away from children.

If you fail to replace the low battery immediately, you may lose important data or applications.

Note: If the CK3 is not using external power and you remove the battery pack, the CK3 goes into Suspend mode.

For replacement batteries, contact your Intermec representative.
Chapter 1 — Using the Computer

Charging the Battery

Make sure you fully charge the AB17 or AB18 battery before you use your CK3. You can charge the battery before or after you install it in the CK3. A fully discharged battery charges in approximately 4 (AB17) to 7 (AB18) hours.

To charge the battery

• Insert the battery into the battery bay of the AD20 single dock, or insert up to four batteries into the AC20 quad battery charger.

Or,

• Install the battery in the CK3 and insert the CK3 into the AD20 single dock, AD21 Ethernet multidock, AD22 charge-only multidock, AE33 vehicle battery adapter, or AV10 vehicle dock.

Use the next table to understand how long it takes to charge your batteries in each of the CK3 charger or dock accessories.

Charging Times for CK3 Batteries

<table>
<thead>
<tr>
<th>CK3 Charging Accessory</th>
<th>AB17 Charging Time</th>
<th>AB18 Charging Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC20 quad battery charger</td>
<td>up to 4 hours</td>
<td>up to 6 hours</td>
</tr>
<tr>
<td>AD20 single dock</td>
<td>up to 4 hours</td>
<td>up to 6 to 7 hours</td>
</tr>
<tr>
<td>AD21 Ethernet multidock</td>
<td>up to 4 hours</td>
<td>up to 7 hours</td>
</tr>
<tr>
<td>AD22 charge-only multidock</td>
<td>up to 4 hours</td>
<td>up to 7 hours</td>
</tr>
<tr>
<td>AE33 vehicle battery adapter</td>
<td>up to 4 hours</td>
<td>up to 7 hours</td>
</tr>
<tr>
<td>AV10 vehicle dock</td>
<td>up to 4 hours</td>
<td>up to 7 hours</td>
</tr>
</tbody>
</table>

Removing and Installing the Battery

To maximize the time allowed to replace the main battery pack, put the CK3 in suspend mode before removing the battery pack.

To remove and install the battery

1. Press and hold @ for about 2 seconds. When you release @, the CK3 goes into suspend mode.

2. If necessary, disconnect the handstrap from the bottom of the CK3.
Chapter 1 — Using the Computer

3 Press the battery release tab toward the battery until the battery releases, and then lift it away from the CK3.

4 Insert the battery into the CK3, and press down on the battery until it clicks into place.

Maximizing Battery Life

Batteries are chemical devices. If the batteries are left sitting on a shelf for long periods of time outside the CK3, the batteries slowly discharge, eventually to zero if left uncharged. The battery chemistry resists normal degradation if you store the battery in a charger as opposed to leaving the battery in a discharged state. See the following table for tips to maximize the life of your battery.

Battery Conservation Tips

<table>
<thead>
<tr>
<th>When You Want To:</th>
<th>Do This to Save Battery Power:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operate the CK3 and the Low Battery status icon appears or the Battery LED</td>
<td>Press  to turn off the CK3. Remove the battery and insert another fully charged battery within</td>
</tr>
<tr>
<td>comes on.</td>
<td>10 minutes or you may lose data. Or, you can connect the CK3 to an external power source.</td>
</tr>
<tr>
<td>Stop using the CK3 for 5 minutes or longer.</td>
<td>Make sure the low battery icon is not on the screen and that the Battery LED is not turned on.</td>
</tr>
<tr>
<td>Store the CK3 for more than a day.</td>
<td>If you are storing the CK3 for a few days, like over the weekend, install the charged battery</td>
</tr>
<tr>
<td></td>
<td>or attach the CK3 to a power source.</td>
</tr>
<tr>
<td>Store the battery outside the CK3.</td>
<td>If you are storing the CK3 for longer, remove and charge the battery, then store both the</td>
</tr>
<tr>
<td>Store the battery in a charger.</td>
<td>battery and the CK3 in a cool location.</td>
</tr>
<tr>
<td></td>
<td>If the battery in storage is not used in several months, you should recharge the battery to</td>
</tr>
<tr>
<td></td>
<td>keep it at its performance peak.</td>
</tr>
</tbody>
</table>


Chapter 1 – Using the Computer

Checking the Battery Status

The easiest way to check the status of your battery is to look at the battery icon on the status bar of your CK3.

**Battery Icon Status**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Battery icon]</td>
<td>Battery is fully charged.</td>
</tr>
<tr>
<td>![Battery icon]</td>
<td>Battery has a medium charge. You should be able to work for several more hours before changing batteries.</td>
</tr>
<tr>
<td>![Battery icon]</td>
<td>Battery is low. You need to replace the battery soon.</td>
</tr>
<tr>
<td>![Battery icon]</td>
<td>Battery is critically low. You need to replace the battery now.</td>
</tr>
<tr>
<td>![Battery icon]</td>
<td>Battery is charging.</td>
</tr>
</tbody>
</table>

The Battery Status LED below your CK3 display indicates the charging status of your battery.

**Understanding the Battery Status LED**

<table>
<thead>
<tr>
<th>LED State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady green when the CK3 is connected to external power</td>
<td>The battery is more than 95% charged.</td>
</tr>
<tr>
<td>Blinking red</td>
<td>The battery is low. CK3 goes into Suspend mode. Charge or replace the battery.</td>
</tr>
<tr>
<td>Steady red when the CK3 is connected to external power</td>
<td>The battery is charging.</td>
</tr>
<tr>
<td>Steady red when the CK3 is not connected to external power</td>
<td>The software is not working properly.</td>
</tr>
<tr>
<td>Steady amber</td>
<td>The battery is missing or is unable to charge because the temperature is outside of the charging range.</td>
</tr>
<tr>
<td>Off</td>
<td>The CK3 is not on external power and the battery is operating normally.</td>
</tr>
</tbody>
</table>
Using the Keypad

Use the following sections to understand how to use the keypad. For information on remapping the keypad, you can download the Device IDL Resource Kit from the Intermec web site at www.intermec.com/idl.

The CK3 comes with an alphanumeric keypad, a numeric keypad, or a large 28-key numeric keypad.
The full alphabetic keypad is designed for applications that require primary input of alphabetic data. This keypad also provides special characters, numbers, symbols, and functions by pressing color-coded key sequences.

The numeric keypad is for applications that require mainly numeric data. This keypad also lets you enter special characters, including the alphabet, by pressing color-coded key sequences.

The large numeric 28-key keypad is for browser-based applications that require heavy usage of numeric and navigation keys. This keypad also provides function keys by pressing color-coded key sequences.

**Using the Color-Coded Keys**

Each keypad provides color-coded keys to let you access additional characters, symbols, and functions printed on the keypad overlay. Once you understand how to use the color-coded keys and key sequences, you can access all of the additional features printed on the keypad overlay.
Chapter 1 — Using the Computer

There are two color-coded modifier keys: the orange \[ \textcolor{orange}{\text{Fn}} \] key and the green \[ \textcolor{green}{\text{Fn}} \] key.

**Note:** The large numeric keypad does not support alpha characters. However, you can remap keys and access them with the orange or green color-coded keys. To remap keys, you need the Device Resource Kit which is part of IDL. For help, go to [www.intermec.com/idl](http://www.intermec.com/idl).

**Using the Color-Coded Keys**

<table>
<thead>
<tr>
<th>You Want to:</th>
<th>Press:</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use an orange character or function printed above a key.</td>
<td>[ \textcolor{orange}{\text{Fn}} ] key (LED turns on) and then the key with the character or function printed above it (LED stays on).</td>
<td>On the CK3 alphanumeric keypad, press [ \textcolor{orange}{\text{Fn}} ] and then [ \textcolor{green}{\text{Q}} ] to select the F18 function.</td>
</tr>
<tr>
<td>Use a green character or function printed above a key.</td>
<td>[ \textcolor{green}{\text{Fn}} ] key (LED turns on) and then the key with the character or function printed above it (LED stays on).</td>
<td>On the CK3 alphanumeric keypad, press [ \textcolor{green}{\text{Fn}} ] and then [ \textcolor{green}{\text{3}} ] to select the \textcolor{green}{\text{ok}} function.</td>
</tr>
<tr>
<td>Unlock the green or orange key.</td>
<td>[ \textcolor{green}{\text{Fn}} ] or [ \textcolor{orange}{\text{Fn}} ] once.</td>
<td>Press [ \textcolor{green}{\text{Fn}} ] or [ \textcolor{orange}{\text{Fn}} ] once to unlock the key. The LED turns off.</td>
</tr>
</tbody>
</table>

**Capitalizing Characters**

You can capitalize characters individually, or you can type all capital letters by enabling Caps Lock.

**To capitalize a single character**

- On the alphanumeric keypad, press the \[ \textcolor{green}{\text{Fn}} \] key, and then the \[ \textcolor{green}{\text{A}} \] key to select the Shift function. Press the \[ \textcolor{green}{\text{Fn}} \] key, and the character.
- On the numeric keypad, press the \[ \textcolor{green}{\text{Fn}} \] key, and then the key to select the Shift function.

**To enable Caps Lock**

- On the alphanumeric keypad, press \[ \textcolor{green}{\text{Fn}} \], then the \[ \textcolor{green}{\text{B}} \] key. Press \[ \textcolor{green}{\text{Fn}} \] again to disable the Caps Lock.
- On the numeric keypad, press \[ \textcolor{green}{\text{Fn}} \] \[ \textcolor{green}{\text{1}} \].
Chapter 1 — Using the Computer

The Caps Lock LED lights up green to show that the CK3 is in the Caps Lock mode.

To disable Caps Lock

- Press the color modifier key again.

For information on how to enter specific characters with keystrokes, see “Keypads and Keystrokes” on page 107.

Using the Power Button

When you press the Power button ( ), you put the CK3 into suspend mode. In this lower power mode, the CK3 continues to supply power to all memory, but turns off power to most hardware such as the display. This power-saving feature is designed to prolong battery life.

When you press @ to turn the CK3 back on, your computer resumes at the screen that was displayed when you turned it off. If you are using WPA or 802.1x security, the CK3 may need to reauthenticate before it resumes your application.

If the battery light flashes and your CK3 does not resume after pressing @, your battery may be too low to supply power. Replace the battery. If replacing the battery does not solve the problem, see “Resetting the CK3” on page 77.

Configuring the Backlight Settings

By default, the CK3 goes into Screen Off mode when there is no activity on the computer. Screen Off mode turns off the backlight and display. Press a key or tap the screen to resume activity.

To configure the backlight

1 Tap Start > Settings > the System tab > the Backlight icon > the Battery Power tab.

2 With Turn off backlight if device is not used for checked, select the timeout value (10 seconds, 30 seconds, or 1 to 5 minutes).

You can also use Intermec Settings to configure the backlight settings.
Chapter 1 — Using the Computer

Understanding the Audio Features

The CK3 has a speaker, a microphone, and multiple software tools for configuring the volume of sounds.

Adjusting the Volume of the Speaker

You can adjust the computer volume for your needs and your environment. The volume includes sounds you hear when you tap the screen or scan bar codes with a scanner. You can set the volume to off, very low, low, medium, high, and very high (default).

To adjust the volume of the speaker with the Volume icon

1. Tap the Volume (peaker) icon at the top of the screen.
2. Use your stylus to adjust the volume slider.

You can also use Intermec Settings to adjust the volume.

Using the Push To Talk (PTT) Feature

You can use the PTT feature to:

• record audio on your CK3.
• use your CK3 as a two-way radio.

Recording Audio on Your CK3

You can use the PTT key in the upper right corner of the keypad to automatically record audio on your CK3. What happens when you press the PTT key depends on whether your CK3 is on or is in suspend mode:

• If your CK3 is on:
  • Press the PTT key to start the Note application in audio note mode.
  • Press and hold the PTT key to start the Note application in audio note mode and start recording. You can record using the internal microphone or a headset microphone attached to the CK3 through the AA20 audio adapter. To stop recording, release the PTT button.

• If your CK3 is in suspend mode:
Chapter 1 — Using the Computer

- Press the PTT key to turn on CK3.
- Press and hold the PTT key for about 2 seconds to turn on the CK3 and start the Note application in audio note mode.
- Press and hold the PTT key for more than 2 seconds to turn on the CK3, start the Note application in audio note mode, and start recording. You can record using the internal microphone or a headset microphone attached to the CK3 through the AA20 or 1007AA01 audio adapter. To stop recording, release the PTT key.

To order the AA20 or 1007AA01 audio adapter, contact your local Intermec representative.

Using Your CK3 as a Two-Way Radio
You can also use the PTT feature with audio applications, such as iTalkie™ to communicate between two or more CK3s over the 802.11 radio network. You press the PTT button to talk to another CK3.

For more information, go to www.tabletmedia.com/iTalkie.html.

Using the Touch Screen

The CK3 has a 240 x 320 pixel color touch screen display. The Windows Mobile 6.1 start screen has three distinct areas: the navigation bar, today screen, and command bar.
Chapter 1 — Using the Computer

To turn the screen backlight on and off
- For the alphanumeric keypad, press \[.\]
- For the numeric keypad, press \[×\]

Using the Stylus

Your computer has a stylus for selecting items and entering information on the touch screen.

Functions You Can Perform With the Stylus

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap</td>
<td>Touch the screen once with the stylus to select options, open or close applications, or launch menus from the Command bar.</td>
</tr>
<tr>
<td>Drag</td>
<td>Hold the stylus on the screen and drag across the screen to select text and images.</td>
</tr>
<tr>
<td>Tap and hold</td>
<td>Tap and hold the stylus on an item to see a menu of actions available for that item. On the pop-up menu that appears, tap the action you want to perform.</td>
</tr>
</tbody>
</table>

Understanding the Screen Icons

Use the screen icons on the navigation bar and the command bar to see the network connection status and other system information. For information about the battery icons, see “Checking the Battery Status” on page 7. Some standard Microsoft icons are included in this table.

Screen Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[×]</td>
<td>The volume is turned off. To turn the volume back on, tap this icon and choose your setting.</td>
</tr>
<tr>
<td>[⇌]</td>
<td>The computer is connected to the network.</td>
</tr>
<tr>
<td>[⇌]</td>
<td>The computer is not connected to the network.</td>
</tr>
<tr>
<td>[⌦]</td>
<td>The 802.11 radio is connected to the wireless network.</td>
</tr>
</tbody>
</table>
Aligning the Touch Screen

If the touch screen does not respond when you tap it with the stylus, you may need to calibrate the screen.

**To calibrate the touch screen**

1. Tap **Start > Settings > the Systems tab > Screen**.
   
   **Note:** If the touch screen is so out of alignment that you cannot open the **Start** menu, you can try to align the screen menu using the keypad. For help, see the next procedure.

2. Tap **Align Screen** and follow the instructions to align the screen.

3. Click **ok**.

**To align the touch screen using the keypad**

1. Access the **Start** menu by pressing \(<\text{Esc}>1\)>.

2. Press the **Down** button to select **Settings**.

3. Press **Enter**.

4. Press the **Tab** button until the **Settings** tabs are highlighted.

5. Press the **Right Arrow** button to select the **System** tab.

6. Press **Tab** until the **Screen** icon is highlighted.

7. Tab to **Align Screen** and press **Enter**.

8. Follow the instructions to align the screen.

9. Click **ok**.

If you are still unable to align the touch screen, you can clean boot the CK3. For help, see “**Clean Booting the CK3**” on page 78.
Understanding the Status LEDs

The CK3 has three status LEDs.

**Location of the Status LEDs**

The next table describes the Notification LED, Good Read LED, and Intermec Ready-to-Work™ indicator. For information about the battery status LED, see “Checking the Battery Status” on page 7.

**Understanding the Status LEDs**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification LED</td>
<td>Orange</td>
<td>The CK3 is notifying you of a pending alarm or message.</td>
</tr>
<tr>
<td>Good Read LED</td>
<td>Green</td>
<td>The CK3 has successfully decoded a barcode.</td>
</tr>
<tr>
<td>Intermec Ready-to-Work indicator</td>
<td>Blue</td>
<td>The CK3 is suspending or resuming with the display turned off.</td>
</tr>
<tr>
<td></td>
<td>Blinking blue</td>
<td>You have successfully loaded and activated Intermec Terminal Emulator. Or the Intermec Terminal Emulator application is loaded, but is inactive.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>The Intermec Terminal Emulator application is missing or disabled.</td>
</tr>
</tbody>
</table>
Chapter 1 — Using the Computer

The blue LED usually turns off within 10 seconds, but it may stay on for up to 30 seconds. During this time, do not press the Power button or remove the battery, or you may corrupt the data on your CK3.

The Intermec Ready-to-Work indicator (blue LED) is used by Intermec’s SmartSystems Foundation, an application that lets you manage all of your SmartSystems-enabled devices simultaneously from a central location. For more information, see “Configuring the CK3 Remotely With SmartSystems Foundation” on page 33, or contact your Intermec representative. Custom applications may also use the blue LED for other purposes.

Scanning Bar Codes

The CK3 ships with an internal imager to scan and enter bar code data. You can also connect to:

- cordless scanners, such as the SF51 and SR61 through Bluetooth communications. For help, see “Connecting to a Bluetooth Scanner” on page 35.
- tethered scanners, such as the SR30 and SR61T through the CK3 RS-232 adapter (Model AA21). For help, see the CK3 RS-232 Adapter (AA21) Instructions.

Note: The CK3 with an EX25 near-far range area imager does not support connections to the SR61T.

The type of imager you are using and the type of bar code you are decoding determines the way you scan the bar code. Depending on the imager model, the CK3 supports reading 1D linear bar codes, 2D images, and composite and postal codes. You can identify the imager model by looking at the label inside the battery compartment.

By default, these bar code symbologies are enabled on the CK3:

- Code 39
- Code 128/GS1-128
Chapter 1 — Using the Computer

- DataMatrix (area imagers only)
- PDF417 (if supported)
- EAN/UPC

If you are using bar code labels that are encoded in a different symbology, you need to enable the symbology on the CK3. Use Intermec Settings to enable and disable symbologies. For help, see “Using Intermec Settings Directly on the CK3” on page 31.

The next two sections describe how to scan a bar code label with the linear imager, area imager, and near-far range area imager.

Scanning With the Linear Imager

If your CK3 has a linear imager, use the following procedure to practice scanning a bar code.

**To scan bar code labels with the linear imager**

1. Press \@ to turn on the CK3.
2. Point the scanner window at the bar code label and hold the CK3 at a slight angle 15 to 25 cm (6 to 10 in) from the label.
3. Press the Scan button on the keypad, or pull the trigger on a handle, and direct the red beam so that it falls across all bars in the bar code label.

Use this test bar code:

Code 39 Test Bar Code

*123456*
When the CK3 successfully reads a bar code label, you hear a high beep and the green Good Read LED turns on briefly.

4 Release the **Scan** button or trigger.

**Scanning With an Area Imager**

Your CK3 may come with one of two types of area imagers:
- Extended range area imager
- Near-far range area imager

Both area imagers are equipped with a laser pointer and framer to help you aim at bar codes, allow you to scan 2D bar code symbologies, and support omni-directional (360°) scanning. Omnidirectional scanning lets you position the CK3 in any orientation to scan a bar code label.

**Scanning With the Extended Range Area Imager**

1 Press ® to turn on the CK3.

2 Point the scanner window at the bar code label, and hold the CK3 steady a few inches from the label.

3 Press the **Scan** button or pull the trigger on your scan handle. The laser pointer and illumination beam and frame appear.
4 Use the laser pointer as a guide and aim toward the middle of the bar code. Make sure that the illumination frame covers the bar code you are trying to decode.

When the CK3 successfully reads a bar code label, you hear a high beep, and the Good Read LED turns on briefly.

5 Release the Scan button or trigger.

**Scanning With the Near-Far Range Area Imager**

1 Press @ to turn on the CK3.

2 Point the scanner window at the bar code label.

3 Press the Scan button or pull the trigger. The illumination beam and laser pointer appear.

- For near or close-in scanning distances of 30 cm (11.8 in) or less, use the laser pointer as a guide and aim slightly to the right of the center of the bar code. Make sure the illumination beam covers the bar code you are trying to decode.
• For standard and long range scanning distances of 30 cm (11.8 in) or more, use the laser pointer as a guide and aim toward the middle of the bar code. Make sure that the illumination beam covers the bar code you are trying to decode.

When the CK3 successfully reads a bar code label, you hear a high beep, and the Good Read LED turns on briefly.

4 Release the Scan button or trigger.

Improving the Performance of the Area Imager

If you experience problems scanning a bar code with the 2D imager, try these possible solutions:

• Keep your hand as steady as possible while scanning a label.
• Position the imager as close to the bar code as possible while still being able to capture the entire bar code.
• Enable only the bar codes that you need to use every day.
• Choose a Predefined mode in Intermec Settings:

  a Tap Start > Settings > the System tab > Intermec Settings.
  
  b Tap Data Collection > Internal Scanner > Imager Settings > Predefined Modes and then select one of these options:

<table>
<thead>
<tr>
<th>Predefined Mode</th>
<th>Select if You Are Scanning:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1D</td>
<td>Only 1D labels.</td>
</tr>
<tr>
<td>1D and 2D Standard</td>
<td>All types of bar code labels.</td>
</tr>
<tr>
<td>1D and 2D Bright</td>
<td>In high ambient light, such as outdoors in the sunshine.</td>
</tr>
<tr>
<td>Environment</td>
<td></td>
</tr>
<tr>
<td>1D and 2D Reflective</td>
<td>Glossy labels.</td>
</tr>
<tr>
<td>Surface</td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>In conditions that require customized settings. For more information about these settings, commands, and parameters, see the Intermec Settings Command Reference Manual available from the Intermec web site at <a href="http://www.intermec.com">www.intermec.com</a>.</td>
</tr>
</tbody>
</table>
Chapter 1 — Using the Computer

- If you are scanning multiple bar codes in a small area, use one of these parameters:
  - Aiming beam activation
  - Aim triggering mode
  - Center decoding

To enable these parameters, use Intermec Settings. For help, see “Using Intermec Settings Directly on the CK3” on page 31.

For help scanning using center-decoding, see the next procedure.

To scan a bar code using center-decoding

1. Press  to turn on the CK3.
2. Point the scanner window at the bar code label.
3. Press the Scan button or pull the trigger. The illumination beam and the laser pointer appear.
4. Aim both the illumination beam and the laser pointer at the bar code you want to scan.

Note: The center-decoding parameter only decodes a bar code if the laser pointer is on the bar code and the illumination beam covers the bar code.
When the CK3 successfully reads a bar code label, you hear a high beep and the green Good Read LED turns on briefly.

**Using a microSD Card**

You can use a micro Secure Digital (SD) card to increase file storage and install software. Your CK3 supports microSD™ cards that hold up to 2 GB of information. The microSD card slot is located in the battery compartment.

**To install a microSD card**

1. Remove the battery. For help, see “Removing and Installing the Battery” on page 5.
2 Use a paper clip or slotted screwdriver to remove the cover.

3 Slide the microSD card cover toward the OPEN position and lift the cover.
Chapter 1 — Using the Computer

4 Insert the microSD card.

5 Close the microSD card cover, and slide the cover toward the LOCK position.

6 Replace the cover.

7 Use the stylus to press the reset button in the battery compartment of the CK3.

**Caution**

*Do not use force or a sharp object when pressing the reset button. You may damage the reset button.*

8 Install the battery.
Chapter 1 — Using the Computer

9 Press @ to turn on the CK3:

- You should be able to navigate to the SDMMC Disk folder and see the contents of the microSD card.
- If the microSD card is bootable, your CK3 boots from the card.
- If the microSD card contains operating system upgrade files, the upgrade process automatically starts. For more information, see “Upgrading the System Software” on page 60.

For troubleshooting information, see “Troubleshooting Your CK3” on page 67.
Use this chapter to understand how to configure the CK3 to communicate in your network. This chapter contains these topics:

- Managing the CK3 Using SmartSystems Foundation
- Connecting to a PC
- Configuring the CK3 Parameters
- Configuring the CK3 for Your Network
- Configuring Wireless Security
Managing the CK3 Using SmartSystems Foundation

Intermec’s SmartSystems™ Foundation is a software platform that lets you manage all of your SmartSystems-enabled devices, including the CK3, simultaneously from a central server. The SmartSystems console displays all SmartSystems-enabled computers and peripherals in your network.

Through the console, you can:

• drag-and-drop configuration bundles, operating system updates, and firmware upgrades to multiple computers.
• save configuration settings from a single device and deploy those settings to many devices simultaneously.
• remotely change settings on SmartSystems-enabled computers and peripherals.

The SmartSystems console can report on asset locations and battery status, making it easier to manage your mobile devices.

With an AutoDeploy license, SmartSystems can automatically push software, configuration settings, and other files to connected CK3s. The license also enables Scan-to-Connect, which makes connecting additional CK3s to your wireless network as easy as reading bar codes.

SmartSystems Foundation can be downloaded at no charge from the Intermec web site. For more information, visit www.intermec.com\SmartSystems. To purchase an AutoDeploy license, contact your local Intermec sales representative.

Connecting to a PC

You can use Microsoft ActiveSync to establish a connection between your CK3 and PC. ActiveSync lets you transfer files, synchronize files, remotely debug, and perform other device management activities. ActiveSync is a free application available from the Microsoft web site.
To establish an ActiveSync partnership between your CK3 and PC, you need to physically connect your CK3 to your PC using these accessories:

- AD20 single dock
- USB to mini-USB cable

**To establish an ActiveSync partnership**

1. Download ActiveSync from the Microsoft web site and install ActiveSync on your PC. When installation is complete, the Get Connected dialog box appears.

2. Follow the onscreen instructions to establish a partnership. When the partnership is established, the Microsoft ActiveSync screen appears on your PC.
Chapter 2 — Connecting and Configuring the CK3

Configuring the CK3 Parameters

You can configure many parameters on the CK3 such as the bar code symbologies it decodes or the network settings. The values you set for these parameters determine how the CK3 operates.

Operating parameters can be viewed and changed on the CK3 by using the Intermec Settings application on the computer. There are two ways to access Intermec Settings:

- Remotely via Intermec SmartSystems Foundation. When you use SmartSystems, you can remotely configure all your CK3 computers as well as other SmartSystems-enabled Intermec computers and peripherals. For more information, see the next section.

- Directly on the CK3. Using Intermec Settings on the CK3 changes only the settings on that computer. For more information, see “Using Intermec Settings Directly on the CK3” on page 31.

- You can use a third-party device management product that includes Intermec Settings Configuration Support, such as the Microsoft System Center Mobile Device Manager. Visit http://www.microsoft.com/systemcenter/mobile for more information.

You can also configure the CK3 with configuration bundles that you create using SmartSystems Foundation. For more information, see the SmartSystems Foundation online Help.

Using Intermec Settings Remotely With SmartSystems Foundation

Your CK3 is SmartSystems-enabled, which lets you open Intermec Settings from the SmartSystems console to remotely configure all of your CK3 computers.

For more information on SmartSystems, see “Managing the CK3 Using SmartSystems Foundation” on page 28.

To open Intermec Settings from the SmartSystems console

1 In the SmartSystems console, right-click a CK3.

2 Select Intermec Settings.
Chapter 2 – Connecting and Configuring the CK3

3 Change settings as needed. As you choose parameters, information on each parameter appears in the upper right pane of the Intermec Settings browser.

4 When you are done making changes, choose File > Save Settings.

For help with using Intermec Settings, in the browser click Help > Contents.

For information on all parameters in Intermec Settings, see the Intermec Settings Command Reference Manual.

Using Intermec Settings Directly on the CK3

Use Intermec Settings on the CK3 to configure the computer and view system information.

To open Intermec Settings

- Tap Start > Settings > the System tab > Intermec Settings.

For information about each command, see the Intermec Settings Command Reference Manual.

Navigating in Intermec Settings

<table>
<thead>
<tr>
<th>To Perform This Action</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a command.</td>
<td>Tap the command or use the up and down arrow keys.</td>
</tr>
<tr>
<td>Expand a command.</td>
<td>Tap the command or use the left and right arrow keys.</td>
</tr>
</tbody>
</table>
Hiding Menu Items in Intermec Settings

In Intermec Settings, you can hide items in the CK3 menus, or in the directory tree in the SmartSystems console. Hidden items are not saved when you back up your settings in the SmartSystems console.

In Intermec Settings in the SmartSystems console:

- To hide menu items, right-click a menu item and choose Hide Menu Item from the popup list. Click Yes to clear the confirming message.
- To restore menu items, click the CK3 name at the top of the directory tree to select it, and then choose View > Unhide Items. All hidden menu items are restored.

In Intermec Settings on the CK3:

- To hide menu items, tap and hold the item, and then choose Hide Menu Item from the popup list. Tap Yes to clear the confirming message.
- To restore hidden items in a single menu, tap and hold the menu bar where the item was hidden, and then choose Restore Item Default from the popup list.
- To restore all hidden items in all menus, tap Menu > Unhide All Items.

Note: When you restore default settings in Intermec Settings, only the settings for visible items are restored to defaults. The settings for hidden menu items are not affected. For more information, see the SmartSystems Foundation online Help.
Chapter 2 — Connecting and Configuring the CK3

Configuring the CK3 Remotely With SmartSystems Foundation

Intermec's SmartSystems Foundation lets you manage all of your SmartSystems-enabled devices simultaneously from a central location. The SmartSystems console displays all of the SmartSystems-enabled devices in your network.

Your CK3 is SmartSystems-enabled, which lets you open Intermec Settings from the SmartSystems console to remotely configure all of your CK3 computers.

To open Intermec Settings from the SmartSystems console

1. In the SmartSystems console, right-click a CK3.
2. Select Intermec Settings.

For more information about SmartSystems Foundation, go to the Intermec web site at www.intermec.com/products/smrtsysfoundation/index.aspx.

Configuring the CK3 for Your Network

The CK3 is a versatile mobile computer that you can easily add to your wireless or wired data collection network. You can connect your CK3 using:

- 802.11b/g or 802.11a/b/g radio communications.
- Bluetooth communications.
- Ethernet communications.
- USB and serial communications.

Configuring 802.11 Radio Communications

Caution: Make sure all components with antennas are at least 30 cm (1 ft) apart when power is applied. Failure to comply could result in equipment damage.

Your CK3 has an 802.11b/g or 802.11a/b/g radio to transfer data using wireless communications. This section assumes that your wireless network is set up, including your access points.
Chapter 2 — Connecting and Configuring the CK3

To configure 802.11 radio parameters
1. Tap Start > Settings > the Systems tab > Intermec Settings.
2. Tap Communications > 802.11 Radio > Funk Security > [Profile #] > SSID.
3. Enter your SSID (network name).
4. If you are not using DHCP, tap IP Settings and configure your network settings.
5. Make sure that your CK3 is talking to the network and that the network can see your CK3.
6. Configure security. For help, see “Configuring Wireless Security” on page 41.

Configuring Bluetooth Communications
You CK3 is Bluetooth™-enabled, which lets you connect to other Bluetooth devices, such as:

• scanners.
• printers.
• audio devices.

You need to turn on the Bluetooth radio before you can discover and connect to other Bluetooth devices. By default, the radio is turned off.

To turn on the Bluetooth radio
1. Tap Start > Settings > the Connections tab > Bluetooth > the Mode tab.
2 Tap **Turn on Bluetooth**.

3 (Optional) If you want your CK3 to be visible to other Bluetooth devices, tap **Make this device visible to other devices**.

4 Click **ok**.

The Bluetooth radio maintains its current state through a warm or cold boot and maintains virtual COM ports. But, if you clean boot your CK3, you need to recreate pairings to devices.

You can also access Bluetooth settings using Intermec Settings.

**To access Bluetooth settings using Intermec Settings**

- In Intermec Settings, tap **Communications > Bluetooth**.

For more information about Bluetooth settings, see the *Intermec Settings Command Reference Manual*.

**Connecting to a Bluetooth Scanner**

You can connect to an Intermec Bluetooth scanner, such as the SF51 or SR61, using one of these methods:

- Create and scan a connection configuration label using EasySet.
- Run the Wireless Scanning Wizard.

**Note:** For both methods, you need the Bluetooth address. The Bluetooth address is on the labels located on the outside of the CK3 shipping box, and on the packet of information that ships with the mobile computer.
Chapter 2 — Connecting and Configuring the CK3

To create a connection configuration label using EasySet

1 Download EasySet from the Intermec website at www.intermec.com.

2 Click the Products tab.

3 Using the Products page, navigate to your product page. Click Computers > Handheld Computers > CK3 > Downloads tab > EasySet ver. 5.6.4.2.

4 Follow the instructions to download EasySet.

5 Open EasySet.

6 Select Interface > Bluetooth > Connect/disconnect > Compose BT address. The Bluetooth - Connect/disconnect - Compose BT address screen appears.

7 Enter the BT address listed on the labels.

8 Click OK.

To connect to a Bluetooth scanner with a connection configuration label

1 Make sure that the Bluetooth radio on your CK3 is enabled and that your CK3 is visible and connectable.

2 Make sure that your Bluetooth scanner is on.

3 With your Bluetooth scanner, scan the Bluetooth EasySet connection configuration label.

4 When prompted, enter the passcode for your scanner. The default passcode for Intermec Bluetooth scanners is 0000.

5 Tap Finish.
To connect to a Bluetooth scanner with the Wireless Scanning Wizard

1 Select Start > Settings > the System tab > Wireless Scanning.

2 Follow the onscreen instructions to connect to a scanner.

Configuring Bluetooth Communications for Wireless Printing

To configure your CK3 for Bluetooth wireless printing, you need to:

- make sure Bluetooth power is on. For help, see the procedure in “Configuring Bluetooth Communications” on page 34.
- create an application that opens the wireless printing COM port on your CK3. For help, see the Bluetooth Resource Kit, part of the Intermec Developer Library (IDL), available from the Intermec web site at www.intermec.com/idl.
- select the current wireless printer on the CK3. For help, see the next procedure.
Chapter 2 — Connecting and Configuring the CK3

To select the current wireless printer

1. Select **Start > Settings > the System tab > Wireless Printing**.

2. Tap **Search** to find a printer, or tap **Manual** to enter a device address. Follow the onscreen instructions to select the current wireless printer.

3. (Optional) Tap **Print Test Page**. The printer prints out the test page.

*Note:* You can also print wirelessly using Microsoft APIs with Bluetooth extensions for Winsock and Bluetooth virtual COM ports. For help, see the IDL, available from the Intermec web site at [www.intermec.com/idl](http://www.intermec.com/idl).

**Connecting to a Bluetooth Audio Device**

Use the Bluetooth Audio applet to discover, activate, and connect to Bluetooth audio devices such as a Bluetooth headset.
Chapter 2 — Connecting and Configuring the CK3

To connect to a Bluetooth audio device

1. Select **Start > Settings > the System tab > Bluetooth Audio**. The Bluetooth Audio screen appears.

![Bluetooth Audio Screen](image)

2. Follow the onscreen instructions to connect to a Bluetooth audio device.

Configuring Ethernet Communications

You connect your CK3 to your Ethernet network with an Ethernet cable and one of these accessories:

- AD20 single dock with an AA12 Ethernet adapter
- AD21 Ethernet multidock

To use your CK3 in an Ethernet network

1. Connect your CK3 to an Ethernet network with an AD20 or AD21. Ethernet communications is automatically enabled on your CK3.
Chapter 2 — Connecting and Configuring the CK3

Configure these network parameters:
• If you have a DHCP server, enable DHCP.
• If you do not have a DHCP server, set these parameters:
  a IP address
  b Subnet mask
  c Default router

If necessary, set these parameters:
• Primary and secondary DNS servers
• Primary and secondary WINS servers

Make sure that your CK3 is communicating with the network and that the network can see your CK3.

Using Serial and USB Communications

You can use these CK3 accessories to transmit data to and receive data from another device through serial or USB communications:
• AD20 single dock
• AV10 vehicle dock
• AA21 RS-232 adapter

For more information about these accessories and how to order them, see “Accessories” on page 94.

Checking the Status of Your Wireless Connection

After you configure your wireless settings, you can use iConnect to check the status of your connection. You can also use iConnect to configure the network settings and test the connection of your CK3 against the network.

To check the status of your wireless connection

1 Tap the iConnect icon ( ) in the lower right corner of the Today screen.

2 From the iConnect menu, select Status > Wireless. The Wireless Status screen appears and checks the connection.
Chapter 2 — Connecting and Configuring the CK3

To configure the network settings
• From the iConnect menu, tap **Tools > Wireless Settings**.

To test the connection of your CK3 against your network
• From the iConnect menu, select **Tools > Ping Test**.

Configuring Wireless Security

The CK3 provides four types of security for your wireless network:
• Wi-Fi Protected Access 2 (WPA2™)
• Wi-Fi Protected Access (WPA)
• 802.1x
• WEP

This section explains how to configure wireless security on your CK3. If you choose not to use security, see “Disabling Security” on page 52. Intermec recommends that you always implement security. You must use either Funk or Microsoft security to implement your security solution. For details, see the next section, “Choosing Between Funk and Microsoft Security.”

If you are using WPA-802.1x, WPA2-802.1x, or 802.1x security, this section also assumes that your authentication server and authenticators are properly configured.

**Note:** Your security choice does not depend on your authentication server. For example, you can choose Funk security if you use Microsoft Active Directory® to issue certificates.
Chapter 2 — Connecting and Configuring the CK3

Choosing Between Funk and Microsoft Security

The CK3 supports both Funk and Microsoft security. The option you choose depends on your network security needs.

Understanding Microsoft and Funk Security

<table>
<thead>
<tr>
<th>Security Choice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft</td>
<td>Microsoft security dynamically selects wireless networks based on your preferences. If you are primarily using the CK3 to connect to Wi-Fi hotspots, you may want to use Microsoft security. To use Microsoft security, you need to select it as your security choice. For help, see “Selecting Microsoft as Your Security Choice” on page 47.</td>
</tr>
<tr>
<td>Funk (default)</td>
<td>Funk security offers features that are similar to Microsoft security, but Funk also offers these features:</td>
</tr>
<tr>
<td></td>
<td>• CCX v4.0 compliance</td>
</tr>
<tr>
<td></td>
<td>• Support for LEAP and TTLS</td>
</tr>
<tr>
<td></td>
<td>• Configuration of up to four profiles</td>
</tr>
<tr>
<td></td>
<td>If you are using the CK3 in a static environment that requires a high level of security, you should use Funk security.</td>
</tr>
<tr>
<td></td>
<td>To use Funk security, you need to select a profile. For help, see the next section, “Selecting a Funk Security Profile.”</td>
</tr>
</tbody>
</table>

Selecting a Funk Security Profile

You can define up to four profiles for Funk security. Different profiles let your CK3 communicate in different networks without having to change all of your security settings. For example, you may want to set up one profile for the manufacturing floor and one for the warehouse. By default, the active profile is Profile 1.

**Note:** You can also use the Profile Wizard to configure most wireless security settings. To start the Profile Wizard, tap the iConnect icon ( homosex ) in the lower right corner of the Today screen and select **Tools > Wireless Settings.**

**To select a Funk security profile**

1. Start Intermec Settings.
2. Choose **Communications > 802.11 Radio > Funk Security.**
Chapter 2 — Connecting and Configuring the CK3

3 Tap a profile to expand it.

4 (Optional) In the Profile Label text box, enter a meaningful name for your profile.

5 Configure your security settings. For help, see the next sections.

6 Repeat Steps 3 through 5 for each profile you want to define.

7 Select one profile as the active profile by tapping Active Profile and choosing a profile from the list.

8 Save your settings.

Configuring WPA Security With Funk Security

Use these procedures to set WPA-802.1x, WPA2-802.1x, WPA-PSK, or WPA2-PSK security on your CK3 with Funk security.

To configure WPA-802.1x or WPA2-802.1x with Funk security

1 Make sure the communications and radio parameters on your CK3 are configured.

2 Make sure Funk is selected as your security choice.

3 Start Intermec Settings.

4 Choose Communications > 802.11 Radio > Funk Security.

5 Select the profile you want to configure.

6 For Association, choose WPA or WPA2. Encryption automatically defaults to TKIP or AES, respectively.

7 For 8021x, choose TTLS, PEAP, EAP-FAST, or TLS and press Enter.

8 If you choose TTLS or PEAP:
   a For Prompt for Credentials, choose Enter credentials now. Note: You can use Prompt for Credentials to troubleshoot your network connection.
   
   b Tap User Name, enter your user name, and press Enter.
   
   c Tap User Password, enter your password, and press Enter.
Chapter 2 — Connecting and Configuring the CK3

For Validate Server Certificate, choose Yes and press Enter.  

Note: The correct date must be set on your CK3 when you enable Validate Server Certificate.

If you choose TLS:

a. Load a user and root certificate on your CK3. For help, see “Loading a Certificate” on page 50.

b. Enter a User Name and Subject Name.

c. For Validate Server Certificate, choose Yes and press Enter.

d. (Optional) To increase your level of security, enter a Server 1 Common name and a Server 2 Common name.

9. Save your settings and exit Intermec Settings.

To configure WPA or WPA2 with Funk security

1. Make sure the communications and radio parameters on your CK3 are configured.

2. Make sure Funk is selected as your security choice.


5. Select the profile you want to configure.

6. For Association, choose WPA or WPA2 and press Enter.

7. For 8021x, choose None and press Enter.

8. For Pre-Shared Key, enter the pre-shared key or passphrase.

   The pre-shared key must be a value of 32 hex pairs preceded by 0x for a total of 66 characters. The value must match the key value on the access point. The passphrase must be from 8 to 63 characters. After you enter a passphrase, the CK3 internally converts it to a pre-shared key.

   This value must match the passphrase on the authenticator.

9. Save your settings and exit Intermec Settings.
Chapter 2 — Connecting and Configuring the CK3

Configuring 802.1x Security With Funk Security

1. Make sure the communications and radio parameters on your CK3 are configured.
2. Make sure Funk is selected as your security choice.
5. Select the profile you want to configure.
6. For Association, choose Open and press Enter.
7. For Encryption, choose WEP and press Enter.
8. For Authentication, choose TTLS, PEAP, or TLS and press Enter.
9. If you choose TTLS or PEAP:
   a. Tap User Name, enter your user name, and press Enter.
   b. Tap Password prompt, choose Enter password now, and press Enter.
      Note: You can use Password prompt to troubleshoot your network connection.
   c. Tap User Password, enter your password, and press Enter.
   d. For Validate Server Certificate, choose Yes and press Enter.
10. If you choose TLS:
   a. Load a user and root certificate on your CK3. For help, see “Loading a Certificate” on page 50.
   b. For Validate Server Certificate, choose Yes and press Enter.
   c. Enter a User Name and Subject Name.
   d. (Optional) To increase your level of security, enter a Server 1 Common name and a Server 2 Common name.
10. Save your settings and exit Intermec Settings.
Chapter 2 – Connecting and Configuring the CK3

Configuring LEAP Security on Your CK3
1 Make sure the communications and radio parameters on your CK3 are configured.
2 Make sure Funk is selected as your security choice.
3 Start Intermec Settings.
4 Choose Communications > 802.11 Radio > Funk Security.
5 Select the profile you want to configure.
6 For 8021x, choose LEAP and press Enter.
7 For Association, choose Open, WPA, WPA2, or Network EAP and press Enter. Encryption automatically defaults to TKIP if you choose WPA, AES if you choose WPA2, and WEP if you choose Open or Network EAP.
8 For Prompt for Credentials, choose Enter credentials now.
9 Tap User Name, enter your user name, and press Enter.
10 Tap User Password, enter your password, and press Enter.
11 Save your settings and exit Intermec Settings.

Configuring Static WEP Security With Funk Security
1 Make sure the communications and radio parameters on your CK3 are configured.
2 Make sure Funk is selected as your security choice.
3 Start Intermec Settings.
4 Choose Communications > 802.11 Radio > Funk Security.
5 Select the profile you want to configure.
6 For Association, choose Open and press Enter.
7 For Encryption, choose WEP and press Enter.
8 For 8021x, choose None.
9 Define a value for the keys you want to use. You can define up to four keys (Key 1 through Key 4).

Enter an ASCII key or a hex key that is either 5 bytes or 13 bytes long depending on the capability of the radio. Set a 5-byte value
for 64-bit WEP or a 13-byte value for 128-bit WEP. Hex keys must be preceded by 0x and contain 5 or 13 hex pairs.

10 For Transmit key, choose the key you want to use for transmitting data.

11 Save your settings and exit Intermec Settings.

**Selecting Microsoft as Your Security Choice**

The default security setting is Funk. If you want to use Microsoft security, you need to select it as your security choice. After you select Microsoft as your security choice, you will be prompted to save your settings and reset your CK3 for your change to take effect.

With Microsoft as your security choice, you can configure:

- WPA.
- 802.1x.
- Static WEP.

**To select Microsoft security as your security choice**

1 Select **Start** > **Settings** > the **System** tab > **Intermec Settings**. The Intermec Settings application appears.

2 Select **Communications** > **802.11 Radio** > **Security Choice**.

3 From the **Security Choice** list, select **Microsoft Security** and save your settings. An alert box appears telling you that you must save your settings and warm boot the CK3 for the new security choice to take effect.

4 Tap **Yes**. The CK3 resets and starts with Microsoft Security as the Security Choice.

**Configuring WPA Security With Microsoft Security**

Use these procedures to set WPA-802.1x and WPA-PSK security on your CK3 with Microsoft security.

**To enable WPA-802.1x with Microsoft security**

1 Make sure the communications and radio parameters on your CK3 are configured.

2 Start Intermec Settings.

3 Choose **Communications** > **802.11 Radio** > **Microsoft Security**.
Chapter 2 — Connecting and Configuring the CK3

4 For Infrastructure Mode, choose Infrastructure.

5 For Network Authentication, choose WPA. Data Encryption automatically defaults to TKIP.

6 For 802.1x Authentication, choose either TLS or PEAP.

7 If you choose TLS:
   a Select Properties and tap the Run App button. The Auth. Settings dialog box appears.
   b Tap the Select button.
   c Select your certificate from the list and press Enter. The User Logon dialog box appears.
   d Enter a User Name and Domain and press Enter.

If you choose PEAP:
   a Select Properties and tap the Run App button. The Auth. Settings box appears.
   b Select Validate Server and press Enter. When the radio starts to authenticate, the Network Password dialog box appears.
   c Enter a User Name and Password and select Save Password.
   d (Optional) In the Domain field, enter the Active Directory domain associated with the user account.
   e Press Enter.

8 Save your settings and exit Intermec Settings.

To enable WPA-PSK With Microsoft Security

1 Make sure the communications and radio parameters on your CK3 are configured.

2 Start Intermec Settings.

3 Choose Communications > 802.11 Radio > Microsoft Security.

4 For Infrastructure Mode, choose Infrastructure.

5 For Network Authentication, choose WPA-PSK. Data Encryption automatically defaults to TKIP.

6 For Pre-Shared Key, enter the pre-shared key or the passphrase.
Chapter 2 — Connecting and Configuring the CK3

The pre-shared key must be a value of 32 hex pairs preceded by 0x for a total of 66 characters. The value must match the key value on the authenticator. The passphrase must be from 8 to 63 characters. After you enter a passphrase, the CK3 internally converts it to a pre-shared key.

This value must match the passphrase on the authenticator.

7 Save your settings and exit Intermec Settings.

Configuring 802.1x Security With Microsoft Security

1 Make sure the communications and radio parameters on your CK3 are configured.

2 Start Intermec Settings.

3 Choose Communications > 802.11 Radio > Microsoft Security.

4 For Infrastructure Mode, choose Infrastructure.

5 For Network Authentication, choose Open.

6 For Data Encryption, choose WEP.

7 For 802.1X Authentication, choose TLS or PEAP.

8 If you choose TLS:
   a Select Properties and tap the Run App button. The Auth. Settings box appears.
   b Tap the Select button.
   c Select your certificate from the list and press Enter. The User Logon dialog box appears.
   d Enter a User Name and a Domain and press Enter.

If you choose PEAP:
   a Select Properties and tap the Run App button. The Auth. Settings box appears.
   b Select Validate Server and press Enter. When the radio starts to authenticate, the Network Password dialog box appears.
   c Enter a User Name and Password and select Save Password.
   d (Optional) In the Domain field, enter the domain.
   e Press Enter.
For Network Key Setting, choose Automatic.

Save your settings and exit Intermec Settings.

Configuring Static WEP Security With Microsoft Security

1. Make sure the communications and radio parameters on your CK3 are configured.
2. Start Intermec Settings.
4. For Network Authentication, choose Open.
5. For Data Encryption, choose WEP.
6. For Network Key Setting, choose Enter Key and Index.
7. For Network Key Value, enter an ASCII key or a hex key that is either 5 bytes or 13 bytes long depending on the capability of the radio.
   Set a 5-byte value for 64-bit WEP or a 13-byte value for 128-bit WEP. Hex keys must be preceded by 0x and contain 5 or 13 hex pairs.
8. For Network Key Index, select the key you want to use for data transmission.
9. Save your settings and exit Intermec Settings.

Loading a Certificate

If you choose to use transport layer security (TLS) with WPA or 802.1x security, you need a unique client certificate on the CK3 and a trusted root certificate authority (CA) certificate. Certificates are pieces of cryptographic data that guarantee a public key is associated with a private key. They contain a public key and the entity name that owns the key. Each certificate is issued by a certificate authority.

To import a certificate

1. Tap the iConnect icon ( ) in the lower right corner of the Today screen. The iConnect pop-up menu appears.
Chapter 2 — Connecting and Configuring the CK3

3 Tap Edit Selected Profile > the Security tab.

4 For 8021x Security, select PEAP, TLS, or TTLS.

5 Tap Get Certificates.

6 To import a root certificate:
   a Tap the <<< button next to the Import Root Certificate field to select the root certificate (DER-encoded .cer file) to import.
   b Click Import Root Cert to install the selected certificate.

To import a user certificate:
   a Tap the <<< button next to the Certificate Path field to select the user certificate (DER-encoded .cer file without the private key) to import.
Chapter 2 — Connecting and Configuring the CK3

b Tap the <<< button next to the Key Path field to select the private key (.pvk file) which corresponds to the user certificate you selected.

To import a certificate from an IAS server:

a Tap Web Enrollment.

b Enter the User, Password, and Server (IP address) to log into the server.

c Tap OK. A dialog box appears asking if you want to load the root certificate.

d Tap OK. The Enrollment Tool message box appears telling you that the certificate has been added.

e Tap OK to close the message box.

Disabling Security

If you choose not to use security with your wireless network, you can disable it on the CK3. Intermec recommends that you always set security in your network.

To disable security

1 Open Intermec Settings.

2 Choose Communications > 802.11 Radio > Microsoft Security.

3 For Network Authentication, choose Open.

4 For Data Encryption, choose Disabled.

5 Close Intermec Settings.
3

Developing and Installing Applications

This chapter contains guidelines for developing applications for the CK3 and contains these sections:

- Developing Applications for the CK3
- Installing Applications on the CK3
- Freeing Up Virtual Memory for Applications
- Launching an Application Automatically
- Upgrading the System Software
Developing Applications for the CK3

Use the Intermec Resource Kits to develop applications to run on the CK3. The Resource Kits are a library of C++, .NET, Java, and web components grouped by functionality that you can use to create applications for the computer. The Resource Kits are part of the Intermec Developer Library (IDL), and can be downloaded from the Intermec web site at www.intermec.com/idl.

For more information, see the Intermec Developer Library Resource Kit Developer’s Guide.

Packaging Your Application

For very simple applications, the executable file may be the only file you need to deploy. More typically, you will have a set of files to install.

Intermec recommends using .cab files to install your applications. The CK3 uses standard Windows Mobile .cab files and will install third-party .cab files.

Choosing a Target Location

You can have your .cab file place your application in any of these memory locations on the CK3:

- The ObjectStore.
- The optional microSD card. Depending on available disk space, you may want to consider installing your application files on the microSD card. Using a card creates the Storage Card folder on the CK3.
- The non-volatile Flash File Store. Applications and data in the Flash File Store will persist through a clean boot.

Note: The Flash File Store may be erased if you reflash the image.
Installing Applications on the CK3

You can install applications on your CK3 by using:

- SmartSystems Foundation.
- Microsoft ActiveSync.
- a microSD card.
- the CK3 FTP server.

For more information on installing applications, see the *Intermec Developer Library Resource Kit Developer’s Guide*.

Installing Applications Using SmartSystems Foundation

You can use the SmartSystems console to drag-and-drop Intermec applications onto your CK3. The console is part of SmartSystems Foundation. For more information, see “Managing the CK3 Using SmartSystems Foundation” on page 28.

To use SmartSystems console to install an application

1. Download your application file from the Intermec web site and unzip it on your desktop PC.
2. Double-click the application file to install it. The application file should appear in the Software Vault.
3. From the SmartSystems console in the Software Vault, drag-and-drop the application onto each CK3 in your network, or drop the application on a group of CK3s contained in a folder.

You can also use SmartSystems Scan-to-Connect to connect the CK3 to your network and install software. For more information, see the SmartSystems Foundation console online Help.

Installing Applications Using Microsoft ActiveSync

When you only have a few computers to update with applications, you can copy files using Microsoft ActiveSync.

This procedure assumes that Microsoft ActiveSync is installed on your PC and is up and running. For more information on installing and using ActiveSync, see “Connecting to a PC” on page 28.
Chapter 3 — Developing and Installing Applications

To install an application on the computer using ActiveSync

1. Connect to the CK3 via ActiveSync. For help, see “Connecting to a PC” on page 28.

2. Copy the .cab files from your development PC to the CK3.

3. Warm boot or cold boot the CK3.

4. After the boot process is finished, browse to the .cab files and tap the files to install them.

Installing Applications Using a Storage Card

For information on installing the microSD card in the CK3, see “Using a microSD Card” on page 23.

To install applications using the storage card

1. Copy your application file to the microSD card.

2. Install the microSD card in the CK3.

3. On your CK3, browse to the Storage Card folder and run your application.

Installing Applications Using the FTP Server

The CK3 has a built-in FTP server that connects to a network through Ethernet, 802.11, or WAN (Wireless Access Network). You can use the server to transfer your application file to the computer. Because you can create FTP scripts to automate the process of copying files to the computer, this option is useful when you need to send files to a large number of computers.

The easiest way to manage the FTP server is to enable the FTP menu within iConnect.

To enable the FTP menu

- Create this DWORD registry key and set it to a value of 1:
  
```
HKEY_CURRENT_USER\Software\iConnect2\IConnect\Settings\ShowFTPMenu
```

  The iFTP menu is available the next time you start iConnect.
To manage the state of the FTP server

- Modify these existing registry keys:

  HKEY_CURRENT_USER\Software\iConnect2\IConnect\Settings\FtpAutoStart
  HKEY_CURRENT_USER\Software\iConnect2\IConnect\Settings\FtpHeartbeat

  where 1 = enable and 0 = disable.

Freeing Up Virtual Memory for Applications

You can use the InstallSelect application to free up virtual memory and create more space to load and run custom applications.

**Note:** InstallSelect is designed for use only by administrators, developers, integrators, or Intermec service representatives. Do not run InstallSelect while using any other applications.

When you free up virtual memory, you reduce the amount of virtual memory used by portions of the SmartSystems Platform Bundle (SSPB) by removing value-added software features. Be sure to back up any related files that you want before you use the InstallSelect application. For more information on SSPB, see “Upgrading the System Software” on page 60.

Removing software features may result in loss of computer functionality or the ability to manage device settings. Contact your Intermec service representative for information about each software feature before making changes.

**To free up virtual memory**

1. Go to Start > Programs > File Explorer.
2. Tap the arrow next to My Documents and select My Device.
3. Tap the Windows folder and scroll down to find InstallSelect.
4. Tap InstallSelect. The Install Select application starts and displays a Caution message box.
5 Tap OK to close the box.

6 Clear the check box of any components you do not want installed after a clean boot. For a description of each component, see the next table.

By default, components already installed on the computer are automatically checked to be installed again after you perform a clean boot.

7 Tap Apply to initiate the clean boot and install only the files that are selected.

8 Tap Yes to continue with the clean boot. The computer performs a clean boot and restarts with all of the checked components installed.

**Install Select Software Components**

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Collection &amp; Intermec Settings</td>
<td>Data collection and Intermec Settings. Also includes on-unit SDK libraries.</td>
</tr>
<tr>
<td></td>
<td>If you disable this .cab file, you cannot scan or collect data on the device and you cannot use Intermec Settings.</td>
</tr>
<tr>
<td>Funk Wireless Security</td>
<td>Intermec security supplicant that provides a wireless security solution with several features that are not supported by Microsoft.</td>
</tr>
<tr>
<td>Printer Support</td>
<td>Provides Intermec printer driver support.</td>
</tr>
</tbody>
</table>
Depending on the options you selected for your CK3, you may see other components available from the InstallSelect application.

**Launching an Application Automatically**

There are two ways to automatically launch your application when you perform a reset on the computer:

- Make sure your .cab file places a shortcut to your application in the \Windows\StartUp folder.
- Configure AutoRun.exe to launch your application.

AutoRun.exe automates operations on your CK3. You can configure AutoRun.exe through the AutoRun data file (AutoRun.dat). For compatibility with other Intermec computers, you can place a copy of AutoRun.exe in the same folder as your AutoRun.dat file.

**To create and install the AutoRun.dat file on your computer**

1. Create a folder called System on your CK3.
2. On your PC, open the Notepad application.
3. Write commands for AutoRun.dat using the supported AutoRun script commands. For help, see the next table.
4. Save the Notepad file as AutoRun.dat.
5. Copy the AutoRun.dat file to the System folder on your CK3. During every boot, the system scans for AutoRun.dat in the System folder.
Chapter 3 – Developing and Installing Applications

AutoRun supports the following script commands in AutoRun.dat.

**AutoRun Script Commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXEC</td>
<td>Launches a specified program and waits for it to finish (up to 10 minutes).</td>
</tr>
<tr>
<td>CALL</td>
<td>Processes a specified file of commands and returns.</td>
</tr>
<tr>
<td>CHAIN</td>
<td>Processes a specified file of commands and does not return.</td>
</tr>
<tr>
<td>RUN</td>
<td>Loads and runs a specified program.</td>
</tr>
<tr>
<td>LOAD</td>
<td>Loads and runs a specified program.</td>
</tr>
</tbody>
</table>

AutoRun handles quoted file names for the first parameter, which allows you to specify path names or file names that contain white spaces. AutoRun only supports one set of quotes per command.

**Upgrading the System Software**

When you upgrade your computer, you are updating the operating system (OS) and the SmartSystems Platform Bundle (SSPB) files.

The SSPB files are stored on the DiskOnChip and deliver Intermec Value Add (IVA) functionality such as data collection, configuration, the Intermec wireless security suite, and SmartSystems Foundation. As new features are added to these components, you can upgrade your SSPB files without needing to upgrade the operating system. Alternately, you can choose to upgrade only the operating system if you need new functionality. If you upgrade the operating system, you will need to reinstall SSPB files.

There are two ways to upgrade your computer:

- You can upgrade your computer using a storage card. For help, see the next section, “Upgrading the CK3 Using a microSD Card.”
- You can upgrade your computer using the SmartSystems Console. For help, see “Upgrading the CK3 Using SmartSystems Foundation” on page 62.

You need to download the latest upgrade files from the Intermec web site to your PC.
To download the upgrade files
1 Start your web browser and go to the Intermec web site at www.intermec.com.
2 Go to Support > Downloads.
3 Click the link to search the product downloads.
4 Select your computer from the Downloads list. The Downloads page displays all of the downloads available for your computer.
5 Download the upgrade file you need. If you want to upgrade both the OS and the SSPB, you will need to download both files.

Upgrading the CK3 Using a microSD Card
To use a microSD card to upgrade the computer, you need an SD card reader and a microSD adapter card formatted as FAT16.

To upgrade the operating system using a microSD card
1 Insert a microSD card into a microSD adapter card and then place it in the storage card reader connected to your PC.
2 Copy all required OS upgrade files to the microSD card.
3 Remove the battery by pressing the release button.
4 Remove the microSD card from the adapter card and insert it into the CK3.
5 Place the CK3 with the battery removed, in a dock connected to external power and press the Reset button (using a stylus) located in the battery cavity on the back of the CK3. For help, see “Cold Booting the CK3” on page 77.
6 Remove the microSD card when the Installation Complete menu appears.
7 Remove the CK3 from the dock and replace the battery.

To upgrade the SSPB using a microSD card
1 Insert a microSD card into a microSD adapter card and then place it in the storage card reader connected to your PC.
2 Copy all required SSPB upgrade files to the microSD card.
3 Remove the microSD card from the adapter card and insert it into the CK3.
Chapter 3 — Developing and Installing Applications

4 Using the stylus, press the Reset button in the battery compartment.

5 Press and hold @ as you insert the battery back into the CK3.

6 Continue to hold @ until a Warning message appears.

7 Release @, read the message, and press either button on the right side to continue.

8 Perform the screen alignment and wait for the CK3 to load files from the microSD card.
   When the progress is complete, the CK3 warm boots to reset the configuration.

9 Remove the microSD card and delete the files.

10 Set the date, time, and network communication parameters to reestablish communications with the other devices in the wireless network.

Upgrading the CK3 Using SmartSystems Foundation

You can use the SmartSystems console to upgrade the operating system on your CK3. The console is part of SmartSystems Foundation and is available from the Intermec web site through the Intermec Developer Library (IDL). Before you can upgrade your CK3, you need:

- SmartSystems Foundation. To download SmartSystems Foundation, go to www.intermec.com/idl and open the Device Management page.

- the device upgrade .exe file. This file is available from the Intermec web site at www.intermec.com. Go to Support > Downloads. Make sure the file you select is for your language.

To upgrade the computer using SmartSystems Foundation

1 Install SmartSystems Foundation on your PC and open the SmartSystems console.

2 Make sure the SmartSystems console and CK3 are on the same subnet.

3 Make sure your CK3 is either in a communications dock or charging dock or the device power management is disabled.

4 Download the device upgrade .exe file to your PC.
Chapter 3 — Developing and Installing Applications

5 Double-click the .exe file on your PC. An InstallShield application starts and walks you through the process of extracting the upgrade files to the default location.

**Note:** Do not change the default location where InstallShield extracts the files. The SmartSystems console requires the files to be in this location.

6 From the SmartSystems console, locate the device upgrade to install.

7 Drag the application to each CK3 you want to upgrade or to a group of CK3s in a folder. The SmartSystems console installs the upgrade on your computers.

After the download is complete, your CK3 replaces the operating system and automatically performs a cold boot.

**Note:** The SmartSystems console indicates that your CK3 is offline, by displaying a red stop sign symbol, until the CK3 reboots and reconnects to the system.
This chapter contains possible solutions to problems you may encounter while using the CK3. This chapter also contains information on booting the computer and these topics:

- Calling Product Support
- Troubleshooting Your CK3
- Resetting the CK3
- Cleaning the Scanner Window and Screen
Chapter 4 — Troubleshooting and Maintaining the CK3

Calling Product Support

If you cannot find the answer to your problem in “Troubleshooting Your CK3” on page 67, you can visit the Intermec technical knowledge base (Knowledge Central) at intermec.custhelp.com to review technical information or to request technical support. If you still need help after visiting Knowledge Central, you may need to call Product Support.

To talk to an Intermec Product Support representative, call 1-800-755-5505.

Before you call Intermec Product Support, make sure you have the following information ready:

• Serial number
• Configuration number
• Operating system version
• SmartSystems Platform Bundle (SSPB) version
• If you are using security, know the type (Funk or Microsoft) and the full set of parameters
• Power management settings
• If you are using Intermec Terminal Emulation (ITE), know the version and protocol
• If you are not using ITE, know the language your custom application was written in and the tools you used to create it

You can find most of the information listed above in Intermec Settings. Consult your application developer for information on your custom application.

To find your configuration number

• Look at the CN field of the configuration label on the back of your CK3.
To find your operating system version

1 Tap Start > Internet Explorer.

2 Tap the Intermec logo. The Intermec page appears and displays the version of the operating system and the SmartSystems Platform Bundle (SSPB) loaded on your CK3.

Troubleshooting Your CK3

Use this section to troubleshoot some common problems you may experience with your CK3.

**Note:** If you send the CK3 in for service, it is your responsibility to save the computer data and configuration. Intermec is responsible only for ensuring that the hardware matches the original configuration when repairing or replacing the computer.

**Problems While Configuring the CK3**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You scan a configuration command, such as Beeper Volume, and you hear</td>
<td>If you are working in Intermec Settings, you cannot scan configuration commands.</td>
</tr>
<tr>
<td>three low beeps and nothing happens.</td>
<td>Exit the application to scan configuration commands.</td>
</tr>
</tbody>
</table>
### Problems While Configuring the CK3 (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You scan or enter an option for the Scanner Model configuration command, and you hear three low beeps and nothing happens.</td>
<td>You may have scanned or entered a Scanner Model command that does not apply to the type of scanner that you have installed. Try scanning or entering the Scanner Model command again and select an option for the type of device you are using.</td>
</tr>
<tr>
<td>You cannot type a character on the keypad or you can only type uppercase or lowercase letters.</td>
<td>You may have locked a modifier key on the keypad. Press the necessary key sequence to unlock the key. For help, see “Using the Keypad” on page 8.</td>
</tr>
</tbody>
</table>
| You press @ and nothing happens. | • Make sure the backlight is on.  
• Make sure you have a charged battery that is installed correctly. For help, see “Charging the Battery” on page 5.  
• The battery may be discharged. Replace the battery with a spare charged battery, or charge the battery.  
• Reset the CK3. For help, see “Resetting the CK3” on page 77. |
| You insert a microSD card and cannot find the SDMMC Disk folder on the CK3. Or, you insert a bootable SD card and the CK3 does not boot from the card. | • The microSD card may not be installed correctly. Insert the microSD card as described in Steps 2 through 4 of “Using a microSD Card” on page 23.  
• The microSD card may be damaged. Try another microSD card. |
| The Battery status LED is on. | • If the battery status LED is a steady green, the battery is more than 95% charged and computer is on a charger.  
• If the battery status LED is blinking red, then the battery is low. Replace or charge the battery.  
• If the battery status LED is a steady red, the main battery is on charge. |
Chapter 4 – Troubleshooting and Maintaining the CK3

Problems While Configuring the CK3 (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
</table>
| The computer appears to be locked up and you cannot enter data.        | • Press the power key to turn off the CK3, and then press the power key again to turn it on.  
  • Press and hold the power key 5 seconds to warm boot the CK3.         |
|                                                                        | • Try reloading the firmware. For help, see “Upgrading the System Software” on page 60. |
|                                                                        | • If the CK3 does not boot or reset, contact your Intermec representative for help. |
| You tap the screen and nothing happens.                                | Align your screen. For help, see “Aligning the Touch Screen” on page 15.            |

Problems With Wireless Connectivity

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you turn on the CK3 after it was suspended for 10 to 15 minutes or longer, the CK3 can no longer send or receive messages over the network.</td>
<td>The host may have deactivated or lost the current terminal emulation session. In a TCP/IP direct connect network, turn off the “Keep Alive” message from host to maintain the TCP session while the computer is suspended.</td>
</tr>
<tr>
<td>The CK3 is connected to the network, and you move to a new site to collect data. Now, your CK3 is not connected to the network.</td>
<td>Move closer to an access point or to a different location to reestablish communications until you reconnect with the network. Any data collected while out of range is transmitted over the network.</td>
</tr>
<tr>
<td>The CK3 appears to be connected to the network, but you cannot establish a terminal emulation session with the host computer.</td>
<td>There may be a problem with the host computer, with the connection between the Intermec Application Server and the host computer, or with the connection between the access point and the host computer. Check with network administrator to make sure the host is running and allowing users to login to the system.</td>
</tr>
</tbody>
</table>
### Problems With Wireless Connectivity (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CK3 appears to be connected to the network, but the host computer is not receiving any information from the CK3.</td>
<td>There may be a problem with the connection between the access point and the host computer. Check with network administrator or use your access point user’s manual.</td>
</tr>
</tbody>
</table>

### Problems While Configuring 802.1x Security

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CK3 indicates that it is authenticated, but it does not communicate with the host.</td>
<td>Make sure the CK3 IP address, host IP address, subnet mask, default router are configured for the network.</td>
</tr>
</tbody>
</table>
| The CK3 does not appear to be authenticating and a network connection icon does not appear on the toolbar. | • The CK3 may not be communicating with the access point. Make sure the CK3 network name matches the access point network name (SSID).  
  • The 802.1x security network may not be active. Make sure the server software is properly loaded and configured on the server PC. See server software documentation for help. |
| A network connection icon appears in the toolbar, but then disappears. | • The CK3 may not be communicating with the intended access point. Make sure the CK3 network name matches the access point network name. Default network name is “INTERMEC.”  
  • The access point may not be communicating with the server. Ensure the access point is turned on, properly configured, and has 802.1x security enabled. |
| You are setting up multiple access points in a network, with different SSIDs, and the connection fails. | When you change the SSID, the WEP key values are not saved. Configure the WEP key values and save your changes. |
Chapter 4 — Troubleshooting and Maintaining the CK3

Problems While Configuring 802.1x Security (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CK3 indicates it is not authenticated.</td>
<td>Make sure that:</td>
</tr>
<tr>
<td></td>
<td>• the User Name and Password parameters on the CK3 match the user name and password on the authentication server. You may need to configure the password on both the CK3 and the authentication server.</td>
</tr>
<tr>
<td></td>
<td>• on your authentication server, the user and group are allowed and the group policy is allowed to log into the server. For help, see the documentation that shipped with your authentication server software.</td>
</tr>
<tr>
<td></td>
<td>• the IP address and secret key for the access point match the IP address and secret key on the authentication server. You may need to configure the IP address and secret key on both your access point and authentication server.</td>
</tr>
<tr>
<td></td>
<td>• the authentication server software is running on the server PC.</td>
</tr>
<tr>
<td>You clean boot the CK3 and this message appears, “The server certificate has expired or your system date is incorrect.”</td>
<td>When you clean boot the CK3, the date and time are not saved. Configure the date and time and save your changes.</td>
</tr>
</tbody>
</table>

Problems While Scanning Bar Codes

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You press the Scan button, but you cannot see a red beam of light.</td>
<td>• You may be too far away from the bar code label. Try moving closer to the bar code label and scan it again.</td>
</tr>
<tr>
<td></td>
<td>• You may be scanning the bar code label “straight on.” Change the scanning angle and try again.</td>
</tr>
<tr>
<td></td>
<td>• Move within two feet of a wall to test the effective scan of the scanner. For help scanning bar codes, see “Scanning Bar Codes” on page 17.</td>
</tr>
</tbody>
</table>

CK3 Mobile Computer User's Manual 71
**Problems While Scanning Bar Codes (continued)**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The input device attached to the CK3 does not work well or read bar code labels very quickly.</td>
<td>Set the Scanner Model command to the specific attached input device. Check enabled bar code symbologies and enable only the symbologies being used.</td>
</tr>
<tr>
<td>When you release <strong>Scan</strong> button, the Good Read LED does not turn off.</td>
<td>If the CK3 is configured to use continuous/edge triggering, the Good Read LED stays on. If the CK3 is configured to use level triggering, there may be a problem. Press the <strong>Scan</strong> button or pull the trigger again without scanning a bar code label. If the LED is still on, contact your local Intermec representative.</td>
</tr>
<tr>
<td>The scanner does not read the bar code label.</td>
<td>• Aim the scanning beam so that it crosses the entire bar code label in one pass. Try changing the scan angle.</td>
</tr>
<tr>
<td></td>
<td>• Check the quality of the bar code label. Scan a bar code label that you know scans well. Compare the two bar code labels to see if the bar code quality is too low. You may need to replace the label that you cannot scan.</td>
</tr>
<tr>
<td></td>
<td>• Make sure the bar code symbology is enabled. For help, see “Using Intermec Settings Directly on the CK3” on page 31.</td>
</tr>
<tr>
<td></td>
<td>• Make sure the application is accepting input by scanning a bar code. You may need to type this information instead.</td>
</tr>
<tr>
<td>The scanner does not read the bar code labels quickly, or the scanning beam seems to be faint or obscured.</td>
<td>The scanner window may be dirty. Clean the window with a solution of ammonia and water. Wipe dry. Do not allow abrasive material to touch the window.</td>
</tr>
<tr>
<td>The scanned bar code data that appears in your application does not match the data encoded in the bar code label.</td>
<td>The CK3 may have decoded the bar code label in a different bar code symbology. Try scanning the bar code label again. Make sure you scan the entire label.</td>
</tr>
</tbody>
</table>
Checking 802.11 Network Status

If you have trouble connecting to your 802.11 wireless network:

- Make sure you have correctly set network parameters on the CK3.
- Check your wireless security settings.

Follow the next procedure to use iConnect to verify available access points and networks, check signal strength, and view other diagnostics. If you need to contact Intermec Product Support, this information can be helpful in troubleshooting wireless network connection issues.

To use iConnect to verify network status

1. Tap the iConnect icon ( ) in the lower right corner of the CK3 screen.
2. Choose Status > Wireless.
3. Tap Advanced. The diagnostics screen appears.

The ISpy tab shows:

- the MAC address and IP address of the 802.11 radio.
- network association status, including the SSID and MAC address of the access point
- security configuration.
- radio transmit power and signal strength information.
4 Tap the **Scan** tab to view a list of available 802.11 networks. The list includes the signal strength, channel, and MAC address for each network.

- Tap **Scan** to refresh the screen.

5 Tap the **Supp** tab to view radio supplicant information, including a list of supplicant events and authentication status.

- To verify the settings for the currently active security profile, tap **Configure Profile**. The Profile Wizard for the active profile appears.
- To try reconnecting to the network, tap **Reconnect**.
- To delete the events in the list, tap **Clear Events**.
Chapter 4 – Troubleshooting and Maintaining the CK3

6 Tap the Ping tab to run a ping test to the host.

To run a ping test:

a In the Host field, enter the IP address of the host.

b From the Repetitions list, choose the number of times the CK3 will ping the host.

c Tap Ping. The graph shows the amount of time it takes for the host to return the ping. Tap List to see this information in a list format.

7 Tap the RSSI tab to view the received signal strength of the host signal.

The information box includes the current signal strength, host SSID name, MAC address, data rate, and transmit power.
Chapter 4 – Troubleshooting and Maintaining the CK3

- Tap Mark to place an arrow marker above the graph.

8 Tap the Conf tab to set up a log file that lists RSSI history.

This screen includes the 802.11 radio driver version and available radio modes.

To create a log file:

a Check the Log to File check box.

b (Optional) Change the sample period and number of samples displayed.

c Tap Log File. The Save As screen appears.

d (Optional) Change the name of the saved log file, the folder to which the file will be saved, the content type (log or text), and the location.

e Tap Save.
Chapter 4 — Troubleshooting and Maintaining the CK3

Resetting the CK3

You seldom need to reset the CK3. However, you do need to reset the CK3 when an application is locked up and does not respond, when you upgrade the firmware, or when you reflash the CK3. The CK3 uses the configuration currently saved in flash memory during the reset process.

There are three ways to reset the CK3:
• Warm boot
• Cold boot
• Clean boot

Warm Booting the CK3

If your CK3 has a charged battery installed but does not resume after you press the Power key, or if the computer or an application is locked up, you may need to warm boot the CK3.

To warm boot your CK3
• Press and hold @ for 5 seconds.
  Or,
• From the SmartSystems console, right-click the CK3 and select Intermec Power Tools > Warm Boot Device.

The CK3 shuts down, restarts, and goes through the initialization process.

Cold Booting the CK3

If the CK3 or application is locked up and does not respond to a warm boot, follow this procedure to perform a cold boot.

Performing a cold boot may result in data loss. When you cold boot the CK3, cached disk data may not be saved, so transactional data may be lost.
Chapter 4 — Troubleshooting and Maintaining the CK3

To cold boot your CK3

1. Press and hold @ for about 2 seconds to suspend the CK3.
2. Remove the battery.
3. Use the stylus to press the reset button in the battery compartment of the CK3.
4. Replace the battery.

Clean Booting the CK3

If the CK3 does not warm boot or cold boot, you may need to perform a clean boot. When you clean boot the CK3, the CK3 only loads files and applications that are absolutely required by the operating system. Perform a clean boot to get the CK3 up and running so that you can run diagnostic tests to troubleshoot the normal boot process.

The clean boot process erases the CK3 memory, including all applications and data files in the object store. To preserve applications through a clean boot, store them in the Flash File Store. For more information, see “Installing Applications on the CK3” on page 55.

Caution: Do not use force or a sharp object when pressing the reset button. You may damage the reset button.
To clean boot the CK3

1 Press and hold @ for about 2 seconds to suspend the CK3.
2 Remove the battery.
3 Use the stylus to press the reset button in the battery compartment of the CK3.
4 Replace the battery.
5 Press and hold both @ and the PTT button.
6 Continue to hold @ and PTT until the “Clean boot the system?” prompt appears on screen.
7 Release the two buttons, read the message, and press the appropriate button to either proceed with the clean boot or cancel the clean boot.

Note: You can also clean boot your CK3 from the SmartSystems console: right-click the CK3 and select Intermec Power Tools > Clean Boot Device.
Chapter 4 – Troubleshooting and Maintaining the CK3

Cleaning the Scanner Window and Screen

To keep the CK3 in good working order, you may need to perform these minor maintenance tasks:

• Clean the scanner window.
• Clean the CK3 screen.

Clean the scanner window and CK3 screen as often as needed for the environment in which you are using the computer. To clean the CK3, use a solution of ammonia and water.

There are no user-serviceable parts inside the CK3. Opening the unit will void the warranty and may cause damage to the internal components.

To clean the scanner window and computer screen

1. Press @ to turn off the CK3.
2. Dip a clean towel or rag in the ammonia solution and wring out the excess. Wipe off the scanner window and screen. Do not allow any abrasive material to touch these surfaces.
3. Wipe dry.
A

Specifications
Appendix A – Specifications

Physical and Environmental Specifications

Physical Dimensions
Length: 21.69 cm (8.54 in)
Width (at widest part): 8.36 cm (3.29 in)
Height (at tallest part): 4.67 cm (1.84 in)

Power and Electrical Specifications
Operating: Rechargeable lithium-ion battery
Backup: Supercap supplies 10 minutes of bridge time while replacing the main battery
Electrical rating: ≡ 4.4 V, 2A; ≡ 4.7 V, 1.5A

Temperature and Humidity Specifications
Operating temperature: -10°C to 50°C (14°F to 122°F)
Storage temperature: -20°C to 70°C (-4°F to 158°F)
Charging temperature: 0°C to 45°C (32°F to 113°F)
Relative humidity (operating): 0 to 95% non-condensing
Environmental rating: IP54

Screen Specifications
- 240 RGB x 320 pixels
- 8.9 cm (3.52 in) diagonal square active area, ¼ VGA
- LED backlight with 5 levels of brightness

CK3 Weight
With EV12 14.41 oz 16.32 oz
With EA20X 14.74 oz 16.66 oz
With EX25 15.73 oz 17.64 oz
Appendix A — Specifications

LCD capable of both portrait and landscape operation

Keypad Options
• Alphanumeric and function keypad
• Numeric and function keypad
• Large numeric and limited function keypad

Bar Code Symbologies

- Australian Post*
- Aztec*
- BPO (British Post 4-state)*
- China Post
- Canada Post
- Codabar
- Codablock A
- Codablock F
- Code 11
- Code 39
- Code 93
- Code 128/GS1-128
- DataMatrix*
- Dutch Post*
- EAN/UPC
- GS1 Composite*
- GS1 DataBar Expanded
- GS1 DataBar Limited
- GS1 DataBar Omnidirectional
- Info Mail
- Interleaved 2 of 5
- Japan Post*
- Matrix 2 of 5
- Maxicode*
- Micro PDF417*
- MSI
- PDF417*
- Planet*
- Plessey
- Postnet*
- QR Code*
- Standard 2 of 5
- Swedish Post
- Telepen
- TLC 39

* These symbologies are only available if your CK3 has an extended range area imager or a near-far range area imager.
**Appendix A – Specifications**

**EV12 Linear Imager Reading Distances**

*Minimum Reading Distances With 0.12 cm (0.05 in) Setback*

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Density</th>
<th>Minimum Distance</th>
<th>Maximum Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39</td>
<td>0.15 mm</td>
<td>9.6 cm (3.8 in)</td>
<td>17.9 cm (7.1 in)</td>
</tr>
<tr>
<td></td>
<td>0.25 mm (10 mils)</td>
<td>7.1 cm (2.9 in)</td>
<td>20.9 cm (8.3 in)</td>
</tr>
<tr>
<td></td>
<td>0.5 mm (20 mils)</td>
<td>6.1 cm (2.5 in)</td>
<td>26.9 cm (10.6 in)</td>
</tr>
<tr>
<td></td>
<td>1 mm (40 mils)</td>
<td>8.1 cm (3.2 in)</td>
<td>33.9 cm (13.4 in)</td>
</tr>
<tr>
<td>EAN/UPC</td>
<td>0.33 mm (13 mils)</td>
<td>6.1 cm (2.5 in)</td>
<td>22.9 cm (9.1 in)</td>
</tr>
</tbody>
</table>

*Minimum reading distances are measured in the dark (0 lux).*

*EV12 Linear Imager Minimum Reading Distances: This graphic does not include the 0.12 cm (0.05 in) setback for the CK3.*
Appendix A – Specifications

Typical Reading Distances With 0.12 cm (0.05 in) Setback*  

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Density</th>
<th>Minimum Distance</th>
<th>Maximum Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39</td>
<td>0.15 mm (6 mils)</td>
<td>9.1 cm (3.6 in)</td>
<td>19.9 cm (7.9 in)</td>
</tr>
<tr>
<td></td>
<td>0.25 mm (10 mils)</td>
<td>6.1 cm (2.5 in)</td>
<td>24.9 cm (9.8 in)</td>
</tr>
<tr>
<td></td>
<td>0.5 mm (20 mils)</td>
<td>5.1 cm (2.1 in)</td>
<td>34.9 cm (13.8 in)</td>
</tr>
<tr>
<td></td>
<td>1 mm (40 mils)</td>
<td>7.1 cm (2.9 in)**</td>
<td>50.9 cm (20.1 in)</td>
</tr>
<tr>
<td>EAN/UPC</td>
<td>0.33 mm (13 mils)</td>
<td>5.1 cm (2.1 in)</td>
<td>27.9 cm (11.0 in)</td>
</tr>
</tbody>
</table>

*Typical reading distances are measured in an office environment (200 lux).

**Minimum distance depends on bar code width and scan angle.

**EV12 Linear Imager Typical Reading Distances:** This graphic does not include the 0.12 cm (0.05 in) setback for the CK3.
**EA20X Extended Range Area Imager Minimum Reading Distances**

*Minimum Reading Distances With 0.2 cm (0.08 in) Setback*

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Density</th>
<th>Minimum Distance</th>
<th>Maximum Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39</td>
<td>0.15 mm (6 mils)</td>
<td>16.2 cm (6.4 in)</td>
<td>21.8 cm (8.6 in)</td>
</tr>
<tr>
<td></td>
<td>0.20 mm (8 mils)</td>
<td>12.2 cm (4.8 in)</td>
<td>30.8 cm (12.1 in)</td>
</tr>
<tr>
<td></td>
<td>0.25 mm (10 mils)</td>
<td>9.2 cm (3.6 in)</td>
<td>40.8 cm (16.0 in)</td>
</tr>
<tr>
<td></td>
<td>0.50 mm (20 mils)</td>
<td>10.2 cm (4.0 in)</td>
<td>70.8 cm (27.9 in)</td>
</tr>
<tr>
<td></td>
<td>1.00 mm (40 mils)</td>
<td>15.2 cm (6.1 in)</td>
<td>99.8 cm (39.3 in)</td>
</tr>
<tr>
<td>EAN/UPC</td>
<td>0.33 mm (13 mils)</td>
<td>9.2 cm (3.6 in)</td>
<td>47.8 cm (18.8 in)</td>
</tr>
<tr>
<td>100%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Matrix</td>
<td>0.18 mm (7 mils)</td>
<td>17.2 cm (6.8 in)</td>
<td>19.8 cm (7.8 in)</td>
</tr>
<tr>
<td></td>
<td>0.25 mm (10 mils)</td>
<td>15.2 cm (6.1 in)</td>
<td>28.8 cm (11.3 in)</td>
</tr>
<tr>
<td></td>
<td>0.38 mm (15 mils)</td>
<td>10.2 cm (4.0 in)</td>
<td>44.8 cm (17.6 in)</td>
</tr>
<tr>
<td>PDF417</td>
<td>0.17 mm (6.6 mils)</td>
<td>15.2 cm (6.1 in)</td>
<td>21.8 cm (8.6 in)</td>
</tr>
<tr>
<td></td>
<td>0.25 mm (10 mils)</td>
<td>10.2 cm (3.9 in)</td>
<td>32.8 cm (12.9 in)</td>
</tr>
<tr>
<td></td>
<td>0.38 mm (15 mils)</td>
<td>11.2 cm (4.4 in)</td>
<td>49.8 cm (19.6 in)</td>
</tr>
</tbody>
</table>

*Minimum reading distances are measured in the dark (0 lux).*
Appendix A — Specifications

EA20X Extended Range Area Imager Minimum Reading Distances: This graphic does not include the 0.2 cm (0.08 in) setback for the CK3.
Appendix A – Specifications

EX25B Near-Far Range Area Imager Reading Distances

1D Symbologies Minimum Reading Distances With 0.24 cm (0.09 in) Setback*

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Density</th>
<th>Minimum Distance</th>
<th>Maximum Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39</td>
<td>0.1 mm (3.8 mils)</td>
<td>18.24 cm (7.18 in)</td>
<td>31.76 cm (12.51 in)</td>
</tr>
<tr>
<td></td>
<td>0.25 mm (10 mils)</td>
<td>18.24 cm (7.18 in)</td>
<td>68.76 cm (27.07 in)</td>
</tr>
<tr>
<td></td>
<td>0.5 mm (20 mils)</td>
<td>19.24 cm (7.57 in)</td>
<td>109.76 cm (43.22 in)</td>
</tr>
<tr>
<td></td>
<td>1 mm (40 mils)</td>
<td>40.24 cm (15.84 in)</td>
<td>219.76 cm (86.52 in)</td>
</tr>
<tr>
<td></td>
<td>1.3 mm (51 mils)</td>
<td>100.24 cm (39.46 in)</td>
<td>309.76 cm (121.96 in)</td>
</tr>
<tr>
<td></td>
<td>2.5 mm (100 mils)</td>
<td>130.24 cm (51.27 in)</td>
<td>429.76 cm (169.20 in)</td>
</tr>
<tr>
<td>EAN 100%</td>
<td>0.33 mm</td>
<td>22.24 cm (7.96 in)</td>
<td>99.76 cm (39.28 in)</td>
</tr>
</tbody>
</table>

* Minimum reading distances are measured in the dark (0 lux).

EX25B Near-Far Range Imager 1D Minimum Reading Distances: This graphic does not include the 0.24 cm (0.09 in) setback for the CK3.
Appendix A – Specifications

1D Symbologies Typical Reading Distances With 0.24 cm (0.09 in) Setback*

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Density</th>
<th>Minimum Distance</th>
<th>Maximum Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39</td>
<td>0.25 mm (10 mils)</td>
<td>16.24 cm (6.21 in)</td>
<td>89.76 cm (35.34 in)</td>
</tr>
<tr>
<td></td>
<td>0.5 mm (20 mils)</td>
<td>18.24 cm (7.00 in)</td>
<td>179.76 cm (70.77 in)</td>
</tr>
<tr>
<td></td>
<td>1 mm (40 mils)</td>
<td>18.24 cm (7.00 in)**</td>
<td>389.76 cm (153.45 in)</td>
</tr>
<tr>
<td></td>
<td>1.4 mm (55 mils)</td>
<td>20.24 cm (7.78 in)**</td>
<td>479.76 cm (188.89 in)</td>
</tr>
<tr>
<td></td>
<td>2.5 mm (100 mils)</td>
<td>20.24 cm (7.78 in)**</td>
<td>869.76 cm (342.43 in)</td>
</tr>
<tr>
<td>EAN 100%</td>
<td>0.33 mm</td>
<td>20.24 cm (7.78 in)</td>
<td>109.76 cm (43.22 in)**</td>
</tr>
</tbody>
</table>

* Typical reading distances are measured in an office environment (200 lux).
** as long as the bar code label fits in the reading area

EX25B Near-Far Range Imager 1D Typical Reading Distances: This graphic does not include the 0.24 cm (0.09 in) setback for the CK3.
### Appendix A – Specifications

**2D Symbologies Typical Reading Distances With 0.24 cm (0.09 in) Setback***

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Density</th>
<th>Minimum Distance</th>
<th>Maximum Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataMatrix</td>
<td>0.25 mm (10 mils)</td>
<td>20.24 cm (7.96 in)**</td>
<td>73.76 cm (29.04 in)</td>
</tr>
<tr>
<td></td>
<td>1.4 mm (55 mils)</td>
<td>20.24 cm (7.96 in)**</td>
<td>339.76 cm (133.77 in)</td>
</tr>
<tr>
<td></td>
<td>2.5 mm (100 mils)</td>
<td>20.24 cm (7.96 in)**</td>
<td>679.76 cm (267.63 in)</td>
</tr>
<tr>
<td></td>
<td>3.5 mm (140 mils)</td>
<td>20.24 cm (7.96 in)**</td>
<td>789.76 cm (310.93 in)</td>
</tr>
<tr>
<td></td>
<td>5 mm (200 mils)</td>
<td>20.24 cm (7.96 in)**</td>
<td>1199.76 cm (472.02 in)</td>
</tr>
</tbody>
</table>

* Typical reading distances are measured in an office environment (200 lux).
** as long as the bar code label fits in the reading area.

Ex25b Near-Far Range Imager 2D Typical Reading Distances: This graphic does not include the 0.24 cm (0.09 in) setback for the CK3.
EX25C Near-Far Range Area Imager Reading Distance

1D Symbologies Minimum Reading Distances With 0.24 cm (0.09 in) Setback*

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Density</th>
<th>Minimum Distance</th>
<th>Maximum Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39</td>
<td>0.08 mm (3 mils)</td>
<td>15 cm (5.91 in)</td>
<td>35 cm (13.78 in)</td>
</tr>
<tr>
<td></td>
<td>0.1 mm (2.8 mils)</td>
<td>15 cm (5.91 in)</td>
<td>45 cm (17.72 in)</td>
</tr>
<tr>
<td></td>
<td>0.25 mm (10 mils)</td>
<td>15 cm (5.91 in)</td>
<td>115 cm (45.28 in)</td>
</tr>
<tr>
<td></td>
<td>0.5 (20 mils)</td>
<td>16 cm (6.30 in)</td>
<td>210 cm (82.68 in)</td>
</tr>
<tr>
<td></td>
<td>1 mm (40 mils)</td>
<td>25 cm (9.84 in)</td>
<td>310 cm (122.05 in)</td>
</tr>
<tr>
<td></td>
<td>1.3 mm (51 mils)</td>
<td>40 cm (15.75 in)</td>
<td>310 cm (165.35 in)</td>
</tr>
<tr>
<td>EAN 100%</td>
<td>0.33 mm</td>
<td>15 cm (5.91 in)</td>
<td>145 cm (57.09 in)</td>
</tr>
</tbody>
</table>

* Minimum reading distances are measured in the dark (0 lux).

EX25C Near-Far Range Imager 1D Minimum Reading Distances: This graphic does not include the 0.24 cm (0.09 in) setback for the CK3.
Appendix A – Specifications

**1D Symbologies Typical Reading Distances With 0.24 cm (0.09 in) Setback***

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Density</th>
<th>Minimum Distance</th>
<th>Maximum Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39</td>
<td>0.25 mm (10 mils)</td>
<td>15 cm (5.91 in)</td>
<td>135 cm (53.15 in)</td>
</tr>
<tr>
<td></td>
<td>0.5 mm (20 mils)</td>
<td>16 cm (6.30 in)</td>
<td>280 cm (110.24 in)</td>
</tr>
<tr>
<td></td>
<td>1 mm (40 mils)</td>
<td>25 cm (9.84 in)</td>
<td>550 cm (216.54 in)</td>
</tr>
<tr>
<td></td>
<td>1.4 mm (55 mils)</td>
<td>40 cm (15.75 in)</td>
<td>720 cm (283.46 in)</td>
</tr>
<tr>
<td></td>
<td>2.5 mm (100 mils)</td>
<td>**</td>
<td>1200 cm (472.44 in)</td>
</tr>
<tr>
<td>Code 128</td>
<td>2.5 mm (100 mils)</td>
<td>**</td>
<td>1300 cm (511.81 in)</td>
</tr>
<tr>
<td>retro-reflective</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EAN 100%</td>
<td>0.33 mm</td>
<td>15 cm (5.91 in)</td>
<td>160 cm (62.99 in)</td>
</tr>
</tbody>
</table>

* Typical reading distances are measured in an office environment (200 lux).
** Minimum distance depends on bar code width and scan angle.

**EX25C Near-Far Range Imager 1D Typical Reading Distances:** This graphic does not include the 0.24 cm (0.09 in) setback for the CK3.
**2D Symbologies Typical Reading Distances With 0.24 cm (0.09 in) Setback**

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Density</th>
<th>Minimum Distance</th>
<th>Maximum Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataMatrix</td>
<td>0.25 mm (10 mils)</td>
<td>15 cm (5.91 in)</td>
<td>90 cm (35.43 in)</td>
</tr>
<tr>
<td></td>
<td>0.76 mm (30 mils)</td>
<td>25 cm (9.84 in)</td>
<td>310 cm (122.05 in)</td>
</tr>
<tr>
<td></td>
<td>1.4 mm (55 mils)</td>
<td>**</td>
<td>450 cm (177.17 in)</td>
</tr>
<tr>
<td></td>
<td>2.5 mm (100 mils)</td>
<td>**</td>
<td>1100 cm (433.07 in)</td>
</tr>
</tbody>
</table>

* Typical reading distances are measured in an office environment (200 lux).

** Minimum distance depends on bar code width and scan angle.

---

EX25C Near-Far Range Imager 2D Typical Reading Distances: This graphic does not include the 0.24 cm (0.09 in) setback for the CK3.
Appendix A – Specifications

Accessories

You can use these accessories (sold and ordered separately) with the CK3. To order accessories, contact your local Intermec sales representative.

Battery (AB17, AB18)
The AB17 standard battery and AB18 extended battery provide main power to the CK3.

Quad Charger (AC20)
The AC20 quad charger charges up to four CK3 batteries at one time.

Single Dock (AD20)
The AD20 single dock powers your CK3 Mobile Computer and charges a spare battery (AB17 or AB18) separately. The single dock also provides a two-wire serial debug port and client and host USB connectivity.

Ethernet Multidock (AD21)
The AD21 Ethernet multidock provides Ethernet connectivity and power to up to four CK3 computers at one time.

Charge-Only Multidock (AD22)
The AD22 charge-only multidock charges up to four CK3 computers at one time.

Vehicle Dock (AV10)
Use the AV10 vehicle dock to hold and charge your CK3 while you are using it on a vehicle.

Vehicle Battery Adapter (AE33)
Use the AE33 vehicle battery adapter to provide power to your CK3 from your vehicle. To use the vehicle battery adapter, you also need the AA23 power adapter.

Audio Adapter (AA20)
Use the audio adapter to connect an audio device, such as a headset, to your CK3.

RS-232 Adapter (AA21)
Use the RS-232 adapter to connect RS-232 devices to your CK3.
Appendix A — Specifications

**Power Adapter (AA23)**
Use the power adapter to provide power to your CK3 from an external power supply.

**Scan Handle**
The scan handle provides you with an alternate way to hold the CK3 and scan bar code labels using a convenient scanning trigger.

**Vehicle Holder**
Use the vehicle holder to store your CK3 when you are not using it.

**Holster**
The holster provides you with a convenient way to carry your CK3 when you are not using it.

**IP30 and SR61 Battery Pack Adapter**
The IP30 and SR61 battery pack adapter lets you charge an AB3 battery using the CK3 quad charger (AC20) or CK3 single dock (AD20).

**CK3 With IP30 Vehicle Holder**
If you attached an IP30 to your CK3, you can use the vehicle holder to store your CK3 when you are not using it.
Appendix A – Specifications
Default Settings
Appendix B — Default Settings

Default Configuration

The following tables list the default values of the configuration commands supported on the CK3. If you restore the CK3 to factory default settings, the CK3 uses these values.

The commands are grouped by function and reflect the organization of Intermec Settings. For detailed information on most of the commands, see the Intermec Settings Command Reference Manual, available from the Intermec web site at www.intermec.com.

Data Collection

Data Collection Settings

<table>
<thead>
<tr>
<th>Data Collection Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Scanner Port</td>
<td>Enable</td>
</tr>
<tr>
<td>Enable Scanner Auto-Detect</td>
<td>Enable</td>
</tr>
<tr>
<td>Scanner Port Baud Rate</td>
<td>38400</td>
</tr>
</tbody>
</table>

Symbology Settings

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australian Post</td>
<td>Disable</td>
</tr>
<tr>
<td>Aztec</td>
<td>Disable</td>
</tr>
<tr>
<td>BPO</td>
<td>Disable</td>
</tr>
<tr>
<td>Canada Post</td>
<td>Disable</td>
</tr>
<tr>
<td>China Post</td>
<td>Disable</td>
</tr>
<tr>
<td>Codabar</td>
<td>Disable</td>
</tr>
<tr>
<td>Codablock A</td>
<td>Disable</td>
</tr>
<tr>
<td>Codablock F</td>
<td>Disable</td>
</tr>
<tr>
<td>Code 11</td>
<td>Disable</td>
</tr>
<tr>
<td>Code 39</td>
<td>Enable</td>
</tr>
<tr>
<td>Code 93</td>
<td>Disable</td>
</tr>
<tr>
<td>Code 128/GS1-128</td>
<td>Enable</td>
</tr>
<tr>
<td>DataMatrix</td>
<td>Enable</td>
</tr>
<tr>
<td>Dutch Post</td>
<td>Disable</td>
</tr>
</tbody>
</table>
### Symbology Settings (continued)

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAN/UPC</td>
<td>Enable UPC A, UPC E, EAN 8, EAN 13</td>
</tr>
<tr>
<td>GS1 Composite</td>
<td>Disable</td>
</tr>
<tr>
<td>GS1 DataBar Expanded</td>
<td>Disable</td>
</tr>
<tr>
<td>GS1 DataBar Limited</td>
<td>Disable</td>
</tr>
<tr>
<td>GS1 DataBar Omnidirectional</td>
<td>Disable</td>
</tr>
<tr>
<td>Info Mail</td>
<td>Disable</td>
</tr>
<tr>
<td>Interleaved 2 of 5</td>
<td>Disable</td>
</tr>
<tr>
<td>Japan Post</td>
<td>Disable</td>
</tr>
<tr>
<td>Matrix 2 of 5</td>
<td>Disable</td>
</tr>
<tr>
<td>Maxicode</td>
<td>Disable</td>
</tr>
<tr>
<td>Micro PDF417</td>
<td>Disable</td>
</tr>
<tr>
<td>MSI</td>
<td>Disable</td>
</tr>
<tr>
<td>PDF417</td>
<td>Enable</td>
</tr>
<tr>
<td>Planet</td>
<td>Disable</td>
</tr>
<tr>
<td>Plessey</td>
<td>Disable</td>
</tr>
<tr>
<td>Postnet</td>
<td>Disable</td>
</tr>
<tr>
<td>QR Code</td>
<td>Disable</td>
</tr>
<tr>
<td>Standard 2 of 5</td>
<td>Disable</td>
</tr>
<tr>
<td>Swedish Post</td>
<td>Disable</td>
</tr>
<tr>
<td>Telepen</td>
<td>Disable</td>
</tr>
<tr>
<td>TLC 39</td>
<td>Disable</td>
</tr>
</tbody>
</table>

### Symbology Option Settings

<table>
<thead>
<tr>
<th>Symbology Option</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preamble</td>
<td>None (disabled)</td>
</tr>
<tr>
<td>Postamble</td>
<td>None (disabled)</td>
</tr>
<tr>
<td>Global Symbology ID</td>
<td>Disable</td>
</tr>
</tbody>
</table>
### Appendix B — Default Settings

#### Scanner Settings

<table>
<thead>
<tr>
<th>Scanner Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware trigger</td>
<td>Enable</td>
</tr>
<tr>
<td>Turn Off After Good Read</td>
<td>Enable/One-shot</td>
</tr>
<tr>
<td>Trigger mode (area imagers only)</td>
<td>Level</td>
</tr>
</tbody>
</table>

#### Imager Settings

<table>
<thead>
<tr>
<th>Imager Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predefined Modes</td>
<td>1D and 2D Standard</td>
</tr>
<tr>
<td>Sticky Aimer LED duration</td>
<td>0 (disabled)</td>
</tr>
<tr>
<td>Signature Image Capture</td>
<td>Disable</td>
</tr>
</tbody>
</table>

#### Decode Security Settings

<table>
<thead>
<tr>
<th>Decode Security Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consecutive Data Validation</td>
<td>0</td>
</tr>
<tr>
<td>Identical Consecutive Timeout</td>
<td>300 ms</td>
</tr>
<tr>
<td>Different Consecutive Timeout</td>
<td>0</td>
</tr>
<tr>
<td>Center Decoding</td>
<td>Disable</td>
</tr>
<tr>
<td>Center Decoding Tolerance</td>
<td>Disable</td>
</tr>
</tbody>
</table>

#### Virtual Wedge Settings

<table>
<thead>
<tr>
<th>Virtual Wedge Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Wedge</td>
<td>Enable</td>
</tr>
<tr>
<td>Grid</td>
<td>Null</td>
</tr>
</tbody>
</table>

#### RFID

#### RFID Settings

<table>
<thead>
<tr>
<th>RFID Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable RFID Service</td>
<td>Enable</td>
</tr>
</tbody>
</table>
### Application Connection Settings

<table>
<thead>
<tr>
<th>Application Connection Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow External BRI Connections</td>
<td>Enable</td>
</tr>
<tr>
<td>BRI TCP Port</td>
<td>2189</td>
</tr>
<tr>
<td>Enable Logging</td>
<td>Disable</td>
</tr>
</tbody>
</table>

### Reader 1 Settings

<table>
<thead>
<tr>
<th>Reader 1 Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Reader</td>
<td>Disable</td>
</tr>
<tr>
<td>Reader Model</td>
<td>IP30</td>
</tr>
</tbody>
</table>

### RFID Module Settings

<table>
<thead>
<tr>
<th>RFID Module Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag Type</td>
<td>EPC Class 1 Gen2</td>
</tr>
<tr>
<td>Dense Reader Mode</td>
<td>Disable</td>
</tr>
<tr>
<td>LBT Channel</td>
<td>5</td>
</tr>
<tr>
<td>LBT Scan Enable</td>
<td>Enable</td>
</tr>
<tr>
<td>Field Separator</td>
<td>Space ()</td>
</tr>
<tr>
<td>ID Report</td>
<td>Enable</td>
</tr>
<tr>
<td>No Tag Report</td>
<td>Disable</td>
</tr>
<tr>
<td>Report Timeout</td>
<td>0 ms</td>
</tr>
<tr>
<td>Timeout Mode</td>
<td>Disable</td>
</tr>
<tr>
<td>ID Timeout</td>
<td>100 ms</td>
</tr>
<tr>
<td>Antenna Timeout</td>
<td>10 ms</td>
</tr>
<tr>
<td>ID Tries</td>
<td>3</td>
</tr>
<tr>
<td>Antenna Tries</td>
<td>3</td>
</tr>
<tr>
<td>Read Tries</td>
<td>3</td>
</tr>
<tr>
<td>Write Tries</td>
<td>3</td>
</tr>
<tr>
<td>Initialization Tries</td>
<td>1</td>
</tr>
<tr>
<td>Lock Tries</td>
<td>3</td>
</tr>
<tr>
<td>Select Tries</td>
<td>1</td>
</tr>
<tr>
<td>Unselect Tries</td>
<td>1</td>
</tr>
</tbody>
</table>
Appendix B – Default Settings

**RFID Module Settings (continued)**

<table>
<thead>
<tr>
<th>RFID Module Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Q</td>
<td>4</td>
</tr>
<tr>
<td>Field Strength dB</td>
<td>30</td>
</tr>
<tr>
<td>Session</td>
<td>2</td>
</tr>
<tr>
<td>Enable Antenna Port 1</td>
<td>Enable</td>
</tr>
<tr>
<td>Enable Antenna Port 2</td>
<td>Disable</td>
</tr>
<tr>
<td>Enable Antenna Port 3</td>
<td>Disable</td>
</tr>
<tr>
<td>Enable Antenna Port 4</td>
<td>Disable</td>
</tr>
<tr>
<td>Bluetooth Power Off</td>
<td>300 s</td>
</tr>
</tbody>
</table>

**Communications**

**Communications Settings**

<table>
<thead>
<tr>
<th>Communications Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>IntermecCK3</td>
</tr>
</tbody>
</table>

**Bluetooth Settings**

<table>
<thead>
<tr>
<th>Bluetooth Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bluetooth Power</td>
<td>Off</td>
</tr>
<tr>
<td>Bluetooth Discoverable</td>
<td>Disable</td>
</tr>
<tr>
<td>Bluetooth Connectable</td>
<td>Disable</td>
</tr>
</tbody>
</table>

**802.11 Radio Settings**

<table>
<thead>
<tr>
<th>802.11 Radio Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Choice</td>
<td>Funk Security</td>
</tr>
<tr>
<td>Allow Security Changes</td>
<td>Enable</td>
</tr>
<tr>
<td>Radio Measurement</td>
<td>0</td>
</tr>
<tr>
<td>Radio Enabled</td>
<td>Enable</td>
</tr>
</tbody>
</table>
## Appendix B – Default Settings

### Funk Security Settings

<table>
<thead>
<tr>
<th>Funk Security Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Profile</td>
<td>1</td>
</tr>
<tr>
<td>Profile Label</td>
<td>Profile_1</td>
</tr>
<tr>
<td>Network Type</td>
<td>Infrastructure</td>
</tr>
<tr>
<td>Channel</td>
<td>3</td>
</tr>
<tr>
<td>SSID</td>
<td>INTERMEC</td>
</tr>
<tr>
<td>Power Mode</td>
<td>Enabled (Fast PSP)</td>
</tr>
<tr>
<td>8021x</td>
<td>None</td>
</tr>
<tr>
<td>Association</td>
<td>Open</td>
</tr>
<tr>
<td>Encryption</td>
<td>None</td>
</tr>
<tr>
<td>Pre-Shared Key</td>
<td>Null</td>
</tr>
<tr>
<td>Transmit Key</td>
<td>Key1</td>
</tr>
<tr>
<td>Prompt for Credentials</td>
<td>Enable</td>
</tr>
<tr>
<td>User Name</td>
<td>anonymous</td>
</tr>
<tr>
<td>User Password</td>
<td>anonymous</td>
</tr>
<tr>
<td>Inner Authentication-TTLS</td>
<td>MS-Chapv2</td>
</tr>
<tr>
<td>Anonymous name</td>
<td>anonymous</td>
</tr>
<tr>
<td>Inner EAP</td>
<td>EAP/MDS</td>
</tr>
<tr>
<td>Inner Authentication-PEAP</td>
<td>EAP/MS-Chapv2</td>
</tr>
<tr>
<td>Subject Name</td>
<td>Null</td>
</tr>
<tr>
<td>Validate Server Certificate</td>
<td>No</td>
</tr>
<tr>
<td>Server 1 Common Name</td>
<td>Null</td>
</tr>
<tr>
<td>Server 2 Common Name</td>
<td>Null</td>
</tr>
<tr>
<td>Mixed Cell</td>
<td>Off</td>
</tr>
<tr>
<td>CCKM</td>
<td>Off</td>
</tr>
<tr>
<td>Automatic PAC Provisioning</td>
<td>Off</td>
</tr>
<tr>
<td>Provisioning PAC Prompt</td>
<td>Off</td>
</tr>
<tr>
<td>Re Provisioning PAC Prompt</td>
<td>Off</td>
</tr>
<tr>
<td>PACManager</td>
<td>Null</td>
</tr>
<tr>
<td>Logging</td>
<td>Off</td>
</tr>
<tr>
<td>Radio Measurement</td>
<td>0</td>
</tr>
<tr>
<td>Radio Enabled</td>
<td>Enable</td>
</tr>
</tbody>
</table>
### Appendix B – Default Settings

#### Ethernet Adapter Settings

<table>
<thead>
<tr>
<th>IP Settings</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>Enable</td>
</tr>
<tr>
<td>DHCP Client Identifier</td>
<td>Null</td>
</tr>
<tr>
<td>Primary DNS</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Secondary DNS</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Primary WINS</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Secondary WINS</td>
<td>0.0.0.0</td>
</tr>
</tbody>
</table>

#### Certificates Settings

<table>
<thead>
<tr>
<th>Certificates Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Root Certificates</td>
<td>False</td>
</tr>
<tr>
<td>Import User Certificates</td>
<td>False</td>
</tr>
<tr>
<td>Import Pac Files</td>
<td>False</td>
</tr>
</tbody>
</table>

#### Ethernet Adapter IP Settings

<table>
<thead>
<tr>
<th>Ethernet Adapter IP Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>Enable</td>
</tr>
<tr>
<td>DHCP Client Identifier</td>
<td>Null</td>
</tr>
<tr>
<td>Primary DNS</td>
<td>Null</td>
</tr>
<tr>
<td>Secondary DNS</td>
<td>Null</td>
</tr>
<tr>
<td>Primary WINS</td>
<td>Null</td>
</tr>
<tr>
<td>Secondary WINS</td>
<td>Null</td>
</tr>
</tbody>
</table>

#### PSK Settings

<table>
<thead>
<tr>
<th>PSK Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Connection</td>
<td></td>
</tr>
<tr>
<td>Host IP</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Host Port</td>
<td>5555</td>
</tr>
</tbody>
</table>
Appendix B – Default Settings

PSK Settings (continued)

<table>
<thead>
<tr>
<th>PSK Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Port</td>
<td></td>
</tr>
<tr>
<td>Baud</td>
<td>115200</td>
</tr>
<tr>
<td>Parity</td>
<td>Even</td>
</tr>
<tr>
<td>Data Bits</td>
<td>7 Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1 Stop Bit</td>
</tr>
<tr>
<td>Flow Control</td>
<td>No Flow Control</td>
</tr>
<tr>
<td>Protocol</td>
<td>Configurable</td>
</tr>
<tr>
<td>EOM1</td>
<td>\x03</td>
</tr>
<tr>
<td>EOM2</td>
<td>\xFFFFFFFFF</td>
</tr>
<tr>
<td>SOM</td>
<td>\x02</td>
</tr>
<tr>
<td>Reader Command</td>
<td>Enable w/o TMF</td>
</tr>
<tr>
<td>LRC</td>
<td>Disable</td>
</tr>
<tr>
<td>Handshake</td>
<td>Disable</td>
</tr>
</tbody>
</table>

Device Settings

Device Settings

<table>
<thead>
<tr>
<th>Device Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Null</td>
</tr>
<tr>
<td>Time</td>
<td>Null</td>
</tr>
<tr>
<td>Adjust for Daylight Time</td>
<td>Disable</td>
</tr>
<tr>
<td>Good Read Beep</td>
<td>One Beep</td>
</tr>
<tr>
<td>Good Read LED</td>
<td>On</td>
</tr>
<tr>
<td>Beeper Volume</td>
<td>Medium</td>
</tr>
</tbody>
</table>

Display Settings

Display Setting

<table>
<thead>
<tr>
<th>Display Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backlight on Battery Power</td>
<td></td>
</tr>
<tr>
<td>Backlight Turns Off After</td>
<td>30 s</td>
</tr>
<tr>
<td>Backlight On Tap</td>
<td>Enable</td>
</tr>
<tr>
<td>Backlight on External Power</td>
<td></td>
</tr>
<tr>
<td>Backlight Turns Off After</td>
<td>1 min</td>
</tr>
<tr>
<td>Backlight On Tap</td>
<td>Enable</td>
</tr>
<tr>
<td>Backlight Level</td>
<td>High</td>
</tr>
<tr>
<td>Screen Rotation</td>
<td>0 degrees</td>
</tr>
</tbody>
</table>
Appendix B – Default Settings

Keypad Settings

<table>
<thead>
<tr>
<th>Keypad Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Button Remapping for Handle Trigger BRI</td>
<td></td>
</tr>
<tr>
<td>Scan Button Remapping for Middle Scan Button</td>
<td>Scanner</td>
</tr>
</tbody>
</table>

Power Management Settings

<table>
<thead>
<tr>
<th>Power Management Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery Power</td>
<td></td>
</tr>
<tr>
<td>Device Turns Off After</td>
<td>2 min</td>
</tr>
<tr>
<td>Screen Turns Off After</td>
<td>1 min</td>
</tr>
<tr>
<td>External Power</td>
<td></td>
</tr>
<tr>
<td>Device Turns Off After</td>
<td>Disable</td>
</tr>
<tr>
<td>Screen Turns Off After</td>
<td>Disable</td>
</tr>
</tbody>
</table>

Device Monitor

Device Monitor Settings

<table>
<thead>
<tr>
<th>Device Monitor Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poll Period</td>
<td>1 min</td>
</tr>
<tr>
<td>Threshold Values</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Backup Battery Charge Remaining</td>
<td>10</td>
</tr>
<tr>
<td>Main Battery Charge Remaining</td>
<td>10</td>
</tr>
<tr>
<td>Storage Load</td>
<td>90</td>
</tr>
<tr>
<td>Memory Load</td>
<td>90</td>
</tr>
</tbody>
</table>

Core Messaging Service

Core Messaging Service Settings

<table>
<thead>
<tr>
<th>Core Messaging Service Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated Server IP</td>
<td>Null</td>
</tr>
<tr>
<td>Server Name</td>
<td>INTERMEC</td>
</tr>
<tr>
<td>Keep Alive Ping Interval</td>
<td>30 s</td>
</tr>
</tbody>
</table>
C

Keypads and Keystrokes
Appendix C – Keypads and Keystrokes

Standard Characters

Use the following tables to learn how to enter standard and other available characters and functions with the keypad. If there is no sequence of keystrokes for a particular character or function, it is only available through the soft input panel (SIP), which can be accessed by tapping the keyboard icon on the touch screen.

Alphanumeric Characters

<table>
<thead>
<tr>
<th>Character</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
<th>Large Numeric 28-Key Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>A</td>
<td>0</td>
<td>Esc</td>
</tr>
<tr>
<td>b</td>
<td>B</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>c</td>
<td>C</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>d</td>
<td>D</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>e</td>
<td>E</td>
<td>#</td>
<td></td>
</tr>
<tr>
<td>f</td>
<td>F</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>g</td>
<td>G</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>h</td>
<td>H</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>i</td>
<td>I</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>j</td>
<td>J</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>k</td>
<td>K</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>l</td>
<td>L</td>
<td>!</td>
<td>F1</td>
</tr>
<tr>
<td>m</td>
<td>M</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>n</td>
<td>N</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>o</td>
<td>O</td>
<td>F1</td>
<td></td>
</tr>
<tr>
<td>p</td>
<td>P</td>
<td>F2</td>
<td></td>
</tr>
<tr>
<td>q</td>
<td>Q</td>
<td>F3</td>
<td></td>
</tr>
<tr>
<td>r</td>
<td>R</td>
<td>F4</td>
<td></td>
</tr>
<tr>
<td>s</td>
<td>S</td>
<td>F5</td>
<td></td>
</tr>
<tr>
<td>t</td>
<td>T</td>
<td>F6</td>
<td></td>
</tr>
<tr>
<td>u</td>
<td>U</td>
<td>F7</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>V</td>
<td>F8</td>
<td></td>
</tr>
<tr>
<td>w</td>
<td>W</td>
<td>F9</td>
<td></td>
</tr>
<tr>
<td>x</td>
<td>X</td>
<td>F10</td>
<td></td>
</tr>
</tbody>
</table>
### Alphanumeric Characters (continued)

<table>
<thead>
<tr>
<th>Character</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
<th>Large Numeric 28-Key Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>y</td>
<td>Y</td>
<td></td>
<td>F11</td>
</tr>
<tr>
<td>z</td>
<td>Z</td>
<td></td>
<td>F12</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>A</td>
<td>F11</td>
</tr>
<tr>
<td>B</td>
<td>A</td>
<td>B</td>
<td>F12</td>
</tr>
<tr>
<td>C</td>
<td>A</td>
<td>C</td>
<td>7</td>
</tr>
<tr>
<td>D</td>
<td>A</td>
<td>D</td>
<td>8</td>
</tr>
<tr>
<td>E</td>
<td>A</td>
<td>E</td>
<td>9</td>
</tr>
<tr>
<td>F</td>
<td>A</td>
<td>F</td>
<td>4</td>
</tr>
<tr>
<td>G</td>
<td>A</td>
<td>G</td>
<td>5</td>
</tr>
<tr>
<td>H</td>
<td>A</td>
<td>H</td>
<td>6</td>
</tr>
<tr>
<td>I</td>
<td>A</td>
<td>I</td>
<td>1</td>
</tr>
<tr>
<td>J</td>
<td>A</td>
<td>J</td>
<td>2</td>
</tr>
<tr>
<td>K</td>
<td>A</td>
<td>K</td>
<td>3</td>
</tr>
<tr>
<td>L</td>
<td>A</td>
<td>L</td>
<td>4</td>
</tr>
<tr>
<td>M</td>
<td>A</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>N</td>
<td>A</td>
<td>N</td>
<td>6</td>
</tr>
<tr>
<td>O</td>
<td>A</td>
<td>O</td>
<td>7</td>
</tr>
<tr>
<td>P</td>
<td>A</td>
<td>P</td>
<td>8</td>
</tr>
<tr>
<td>Q</td>
<td>A</td>
<td>Q</td>
<td>9</td>
</tr>
<tr>
<td>R</td>
<td>A</td>
<td>R</td>
<td>0</td>
</tr>
<tr>
<td>S</td>
<td>A</td>
<td>S</td>
<td>F1</td>
</tr>
<tr>
<td>T</td>
<td>A</td>
<td>T</td>
<td>F2</td>
</tr>
<tr>
<td>U</td>
<td>A</td>
<td>U</td>
<td>F3</td>
</tr>
<tr>
<td>V</td>
<td>A</td>
<td>V</td>
<td>F4</td>
</tr>
<tr>
<td>W</td>
<td>A</td>
<td>W</td>
<td>F5</td>
</tr>
<tr>
<td>X</td>
<td>A</td>
<td>X</td>
<td>F6</td>
</tr>
<tr>
<td>Y</td>
<td>A</td>
<td>Y</td>
<td>F7</td>
</tr>
<tr>
<td>Z</td>
<td>A</td>
<td>Z</td>
<td>F8</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>
### Appendix C – Keypads and Keystrokes

#### Alphanumeric Characters (continued)

<table>
<thead>
<tr>
<th>Character</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
<th>Large Numeric 28-Key Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>9</td>
<td>9</td>
</tr>
</tbody>
</table>

#### Function Keys

<table>
<thead>
<tr>
<th>Function</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
<th>Large Numeric 28-Key Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>F1</td>
<td>F1</td>
<td>F1</td>
</tr>
<tr>
<td>F2</td>
<td>F2</td>
<td>F2</td>
<td>F2</td>
</tr>
<tr>
<td>F3</td>
<td>F3</td>
<td>F3</td>
<td>F3</td>
</tr>
<tr>
<td>F4</td>
<td>F4</td>
<td>F4</td>
<td>F4</td>
</tr>
<tr>
<td>F5</td>
<td>F5</td>
<td>F5</td>
<td>F5</td>
</tr>
<tr>
<td>F6</td>
<td>E</td>
<td>G</td>
<td>F6</td>
</tr>
<tr>
<td>F7</td>
<td>F</td>
<td>F7</td>
<td>F7</td>
</tr>
<tr>
<td>F8</td>
<td>G</td>
<td>F8</td>
<td>F8</td>
</tr>
<tr>
<td>F9</td>
<td>H</td>
<td>F9</td>
<td>F9</td>
</tr>
<tr>
<td>F10</td>
<td>I</td>
<td>F10</td>
<td>F10</td>
</tr>
<tr>
<td>F11</td>
<td>J</td>
<td>F11</td>
<td></td>
</tr>
<tr>
<td>F12</td>
<td>K</td>
<td>F12</td>
<td></td>
</tr>
<tr>
<td>F13</td>
<td>L</td>
<td>L</td>
<td>F1</td>
</tr>
<tr>
<td>F14</td>
<td>M</td>
<td>M</td>
<td>F2</td>
</tr>
<tr>
<td>F15</td>
<td>N</td>
<td>N</td>
<td>F3</td>
</tr>
<tr>
<td>F16</td>
<td>Q</td>
<td>Q</td>
<td>F4</td>
</tr>
<tr>
<td>F17</td>
<td>P</td>
<td>P</td>
<td>F5</td>
</tr>
<tr>
<td>F18</td>
<td>Q</td>
<td>Q</td>
<td>F6</td>
</tr>
<tr>
<td>F19</td>
<td>R</td>
<td>R</td>
<td>F7</td>
</tr>
</tbody>
</table>
### Function Keys (continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
<th>Large Numeric 28-Key Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>F20</td>
<td>F21</td>
<td>F22</td>
<td>F23</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>B</td>
<td>C</td>
</tr>
</tbody>
</table>

### Special Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
<th>Large Numeric 28-Key Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward Tab</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Back Tab</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Space</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backspace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shift</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caps Lock</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field Exit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Up Arrow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Down Arrow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Left Arrow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Right Arrow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alt</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Depending on your CK3 model, some of the following characters or functions will not be printed on the keypad.

### Other Available Characters and Functions

<table>
<thead>
<tr>
<th>Character or Function</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
<th>Large Numeric 28-Key Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>!</td>
<td>!</td>
<td>!</td>
</tr>
</tbody>
</table>
### Other Available Characters and Functions (continued)

<table>
<thead>
<tr>
<th>Character or Function</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
<th>Large Numeric 28-Key Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>@</td>
<td>A</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>#</td>
<td>A</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>$</td>
<td>A</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>%</td>
<td>A</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>^</td>
<td>A</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>&amp;</td>
<td>A</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>*</td>
<td>A</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>(</td>
<td>A</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>)</td>
<td>A</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>OEM Down</td>
<td>v2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CR Select</td>
<td>k4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select</td>
<td>g6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td>^8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>x</td>
<td></td>
<td>[Enter]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A</td>
<td>F4</td>
</tr>
<tr>
<td>:</td>
<td>F1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>?</td>
<td>T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>;</td>
<td>F2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>/</td>
<td>F3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td></td>
<td>[Enter]</td>
</tr>
<tr>
<td>\</td>
<td>F5</td>
<td></td>
<td>[Enter]</td>
</tr>
<tr>
<td>=</td>
<td>F4</td>
<td></td>
<td>SIP</td>
</tr>
<tr>
<td>#</td>
<td>bc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+</td>
<td>5</td>
<td>SIP</td>
<td>[Action]</td>
</tr>
<tr>
<td>[</td>
<td>B</td>
<td></td>
<td>SIP</td>
</tr>
<tr>
<td>.</td>
<td>C</td>
<td></td>
<td>SIP</td>
</tr>
<tr>
<td>]</td>
<td>D</td>
<td></td>
<td>SIP</td>
</tr>
<tr>
<td>,</td>
<td>X</td>
<td></td>
<td>SIP</td>
</tr>
<tr>
<td>‘</td>
<td>Y</td>
<td></td>
<td>SIP</td>
</tr>
<tr>
<td>“</td>
<td>Z</td>
<td></td>
<td>SIP</td>
</tr>
<tr>
<td>Volume Down</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
### Appendix C – Keypads and Keystrokes

#### Other Available Characters and Functions (continued)

<table>
<thead>
<tr>
<th>Character or Function</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
<th>Large Numeric 28-Key Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Menu</td>
<td>☐ 1</td>
<td>☐ 1</td>
<td>☐ 2</td>
</tr>
<tr>
<td>OK</td>
<td>☐ 3</td>
<td>☐ 3</td>
<td>☐ 3</td>
</tr>
<tr>
<td>Volume Up</td>
<td>☐ 5</td>
<td>☐ 5</td>
<td>☐ 6</td>
</tr>
<tr>
<td>Soft Key 1</td>
<td>☐ 7</td>
<td>☐ 7</td>
<td>☐ 7</td>
</tr>
<tr>
<td>Soft Key 2</td>
<td>☐ 9</td>
<td>☐ 9</td>
<td>☐ 9</td>
</tr>
</tbody>
</table>

**Note:** The following ITE functions are only operational when you are using the ITE application. The large numeric 28-key keypad does not support ITE.

#### Intermec Terminal Emulation (ITE) Functions

<table>
<thead>
<tr>
<th>Character or Function</th>
<th>Alphanumeric Keypad</th>
<th>Numeric Keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Exit</td>
<td>(Field Exit)</td>
<td>Field Exit</td>
</tr>
<tr>
<td>System Request</td>
<td>☐ S</td>
<td>☐ S Field Exit</td>
</tr>
<tr>
<td>Home</td>
<td>☐ C</td>
<td>☐ C Field Exit</td>
</tr>
<tr>
<td>Attention</td>
<td>☐ A</td>
<td>☐ A Field Exit</td>
</tr>
<tr>
<td>Reset</td>
<td>☐ ⌂ 4</td>
<td>☐ 1 Field Exit</td>
</tr>
<tr>
<td>Clear</td>
<td>☐ ⌈ 6</td>
<td>☐ 2 Field Exit</td>
</tr>
<tr>
<td>Roll Down</td>
<td>☐ ⌈ 2</td>
<td>☐ 5 Field Exit</td>
</tr>
<tr>
<td>Previous Screen</td>
<td>☐ G</td>
<td>☐ 7 Field Exit</td>
</tr>
<tr>
<td>Roll Up</td>
<td>☐ ⌈ 8</td>
<td>☐ 8 Field Exit</td>
</tr>
<tr>
<td>Next Screen</td>
<td>☐ H</td>
<td>☐ 9 Field Exit</td>
</tr>
<tr>
<td>Page Left</td>
<td>☐ U</td>
<td>☐ ⌂ Field Exit</td>
</tr>
<tr>
<td>Page Up</td>
<td>☐ O</td>
<td>☐ ⌂ Field Exit</td>
</tr>
<tr>
<td>Page Down</td>
<td>☐ P</td>
<td>☐ ⌂ Field Exit</td>
</tr>
<tr>
<td>Page Right</td>
<td>☐ V</td>
<td>☐ ⌂ Field Exit</td>
</tr>
<tr>
<td>Field +</td>
<td>☐ 7</td>
<td>☐ 7 Field Exit</td>
</tr>
<tr>
<td>Field -</td>
<td>☐ 1</td>
<td>☐ 1 Field Exit</td>
</tr>
</tbody>
</table>
Appendix C – Keypads and Keystrokes
Index
Index

Numerics
802.11 radio communications, configuring 33
802.11a standard, described 3
802.1x security
configuring with Funk 45
configuring with Microsoft 49

A
AA20 audio adapter, described 94
AA21 RS-232 adapter, described 94
AA23 power adapter, described 95
AB17 and AB18 battery, described 94
AB3 battery, charging with the IP30 and SR61 battery pack adapter 95
AC20 quad charger
charging times 5
described 94
accessories, described 94
ActiveSync
connecting to a PC 28
using to install applications 55
AD20 single dock
charging times 5
described 94
AD21 Ethernet multidock
charging times 5
described 94
AD22 charge-only multidock
charging times 5
described 94
adjusting the speaker volume 12
AE33 vehicle battery adapter,
described 94
aligning the touch screen 15
alphanumeric keypad. See keypad.
applications
developing
packaging 54
target location on CK3 54
installing
ActiveSync 55
FTP server 56
miniSD card 56
launching automatically 59
area imager
reading distances 86, 88, 91
scanning bar codes 19–21
association label, connecting to a Bluetooth scanner 35
audio adapter, AA20, described 94
audio device, Bluetooth, connecting to 38
audio recordings, creating using the PTT key 12
AutoRun
script commands 60
using to launch other processes 60
AV10 vehicle dock
charging times 5
described 94

B
backlight settings, configuring 11
backup power, battery 4
bar code symbologies
default settings 98
enabled by default 17
supported 83
battery
AB17 and AB18, described 94
backup power 4
battery icons, described 7
charging times 5
checking the status 7
described 4
installing 5
maximizing battery life 6
removing 5
status LED 7
battery pack adapter, IP30 and SR61, described 95
Bluetooth
audio device, connecting to 38
printer, connecting to 37
scanner
connecting to 35
passcode, default 36
Bluetooth Audio applet, described 38
Bluetooth radio communications, configuring 34
turning on 34
booting
clean 78
cold 77
troubleshooting 71
booting (continued)
  warm 77

C
calibrating screen 15
calling product support 66
capitalizing characters 10
caps lock, enabling and disabling 10
card, microSD, using to install applications 56
center-decoding, scanning bar codes 22
certificates
  IAS server, importing from 52
  loading 50
  root, importing 51
characters
capitalizing 10
  entering with keystrokes 108
charging the battery 5
cigarette lighter adapter. See vehicle battery adapter.
CK3 features 2
clean booting
  described 78
  troubleshooting 71
cold booting, described 77
color-coded keys, using 9
communications
  802.11, configuring 33
  Bluetooth, configuring 34
  Ethernet, configuring 39
  serial, using 40
  troubleshooting wireless network 73
  USB using 40
configuration
default settings 98–106
  number, finding 66
configuring
  backlight settings 11
  network communications 33
  remotely with SmartSystems Foundation 33
configuring the CK3
  Intermec Settings 30–32
  SmartSystems console 30
connecting to a PC 28
course 30
contacting Intermec by phone xi

D
default
  bar code symbologies 17
  configuration 98–106

E
EA20X
  performance, improving 21
  reading distances 86
  scanning bar codes 19
environmental specifications 82
errors, finding and solving 67–72
Ethernet communications,
  configuring 39
EV12
  reading distances 84
  scanning bar codes 18
EX25B
  performance, improving 21
  reading distances 88
EX25C
  performance, improving 21
  reading distances 91
extended range area imager
  performance, improving 21
  reading distances 86
  scanning bar codes 19

F
features of the CK3 2
FTP server, using to install applications 56
Funk security
  choosing 42
  configuring 802.1x 45
  LEAP 46
  WEP 46
  WPA 44
  WPA2 44
  WPA-802.1x 43
  WPA2-802.1x 43
  described 42
  selecting a profile 42

G
green key, using 9

H
handle, scan, described 95
hidden characters, typing 111
holder, vehicle
described 95
for CK3 with IP30, described 95
holster, described 95

I
IAS server, certificate, importing 52
iConnect
  enabling FTP server 56
  icon, illustrated 15
  wireless connection, checking
  status 40
icons
  battery, described 7
  screen, described 14
IDL (Intermec Developer Library) 54
imager, area
  center-decoding 22
  extended range reading
distances 86
  near-far range reading distances
  88, 91
  performance, improving 21
  predefined modes 21
  scanning bar codes 19–21
imager, linear
  reading distances 84
  scanning bar codes 18
installing the battery 5
InstallSelect
  software components, described
  58
  using to free up memory 57
Intermec
  contact information ii
  product support
  calling 66
  Knowledge Central web site xi
  support contact information xi
Intermec Developer Library (IDL) 54
Intermec Settings
  configuring CK3 31
  described 30
  menu items, hiding 32
  navigating 31
  restoring menu items 32
  SmartSystems console, opening
  from 30
IP30 and CK3 vehicle holder,
described 95
IP30 and SR61
  battery pack adapter, described
  95
IVA, described 60

K
keypad
  capitalizing characters 10
  color-coded keys, using 9
  hidden characters, typing 111
  illustrated 8
  keystrokes for entering
  characters 108
  options 83
  troubleshooting 68
  using the color-coded keys 9
Knowledge Central web site 66

L
large numeric keypad. See keypad.
launching applications
  automatically 59
LEAP security, configuring with
  Funk 46
LEDs, status
  described 16
  illustrated 16
linear imager
  reading distances 84
  scanning bar codes 18
installing the battery 5
installing the battery
  using the color-coded keys 9
Knowledge Central web site 66

M
manuals, downloading from web
  xii
maximizing battery life 6
memory
  freeing up virtual for
  applications 57
  installing applications in 54
microSD card
  installing 23
  troubleshooting 68
  upgrading CK3 61
  using to install applications 56
Microsoft security
choosing 47
configuring 47–50
  802.1x 49
  WEP 50
  WPA 47
  WPA-802.1x 47
  WPA-PSK 48
described 42
modifier keys, using 9
multidock
  charge-only, AD22, described 94
  Ethernet, AD21, described 94

N
near-far range area imager
  reading distances 88, 91
  scanning bar codes 20
network
  communications, configuring 33
  connection icon
  illustrated 14
  troubleshooting 70
numeric keypad. See keypad.

O
Object Store, storing applications 54
omnidirectional scanning 19
operating system
  upgrading 60
  version, finding 67
orange key, using 9

P
partnership, ActiveSync, establishing 28
passcode, Bluetooth scanner
  default 36
patents, list of xiii
PC, connecting to with ActiveSync 28
PEAP
  choosing with 802.1x Funk security 45
  choosing with 802.1x Microsoft security 49
  choosing with WPA Funk security 43
  choosing with WPA Microsoft security 48
persistent storage manager,
  upgrading 60
physical specifications 82
power adapter, AA23, described 95
power button
  described 11
  troubleshooting 68
printer, Bluetooth, connecting to 37
problems, troubleshooting 67–72
product support
  calling 66
  Knowledge Central web site xi, 66
profile, Funk security, selecting 42
PTT (Push To Talk), described 12

Q
quad charger, AC20, described 94

R
radio
  802.11 communications,
  configuring 33
  Bluetooth
  turning on 34
  Bluetooth communications,
  configuring 34
reading distances
  EA20X 86
  EV12 84
  EX25B 88
  EX25C 91
recording audio, using the PTT key 12
removing the battery 5
resetting the CK3 77
root certificate, importing 51
RS-232 adapter, AA21, described 94

S
safety icons x
scan handle, described 95
scanner window, cleaning 80
scanners
  Bluetooth
  connecting to 35
  passcode, default 36
  supported 17
Index

scanning
  center decoding 22
  omnidirectionally 19
  troubleshooting 71, 72
Scan-to-Connect 28
screen
  aligning 15
  cleaning 80
  icons, described 14
  specifications 82
  touch, described 13
  troubleshooting 69
SD card. See microSD card.
SDMMC Disk folder
  troubleshooting 68
security
  choosing between Microsoft and Funk 42
  configuring 41–50
    Funk 42–47
    Microsoft 47–50
  disabling 52
  Funk, selecting a profile 42
  loading certificates 50
serial communications, using 40
settings
  configuring
    remotely with SmartSystems Foundation 33
  default 98–106
single dock, AD20, described 94
SmartSystems Foundation 28
applications, installing 55
AutoDeploy 28
configuring CK3 remotely 33
Intermec Settings, using from console 30
Platform Bundle
  finding version 67
  upgrading with microSD card 61
Scan-to-Connect 28
upgrading the CK3 62
where to download 28
snap-on adapter
  AA20 audio adapter, described 94
  AA21 RS-232 adapter, described 94
  AA23 power adapter, described 95
software
  version, finding 67
speaker, adjusting the volume 12
specifications
  physical and environmental 82
status LEDs
  battery, described 7
    described 16
    illustrated 16
storage, increasing with microSD card 23
support, contacting Intermec xi
suspend mode, described 11
symbologies. See bar code symbologies.
T
  technical support xi
  TLS
    choosing with 802.1x Microsoft security 49
    choosing with WPA Funk security 44, 45
    choosing with WPA Microsoft security 48
touch screen. See screen.
troubleshooting problems 67–72
TLS
  choosing with 802.1x Funk security 45
  choosing with WPA Funk security 43
U
  uninstalling the battery 5
upgrade files, downloading 61
upgrading
  operating system 60
  persistent storage manager 60
  using microSD card 61
  using SmartSystems console 62
USB communications, using 40
V
  vehicle battery adapter, AE33, described 94
  vehicle dock, AV10, described 94
  vehicle holder
    described 95
    for CK3 with IP30, described 95
  virtual memory, freeing up 57
Index

volume
   adjusting 12
   icon, illustrated 14

W
   warm booting, described 77
   warranty information x
   WEP security
      configuring, Funk 46
      configuring, Microsoft 50
   WiFi communications
      configuring 33
      supported 2
   will not boot from microSD card 68
   window, scanner, cleaning 80
   wireless
      audio device, connecting to 38
      connection, check status with iConnect 40
      printer, connecting to 38
      scanner, connecting to 35
security, configuring 41
   Wireless Scanning Wizard, connecting to a scanner 35
   WPA security
      configuring Funk 44
      configuring with Microsoft 47
   WPA2 security, configuring with Funk 44
   WPA2-802.1x security, configuring with Funk 43
   WPA-802.1x security
      configuring with Funk 43
      configuring with Microsoft 47
   WPA-PSK security, configuring with Microsoft 48
   www.intermec.com
      Intermec Developer Library 54
      Knowledge Central 66
      Product Support 66
      SmartSystems Foundation 28